USER GUIDE applied

biosystems
by&{é technologies”

AmpF/STR® Yfiler® PCR Amplification Kit

for use with:
100 reaction kit (Part no. 4359513)

Publication Number 4358101 Rev. H
Revision Date September 2012

o
technologies™



For Forensic or Paternity Use Only.
Information in this document is subject to change without notice.

DISCLAIMER: LIFE TECHNOLOGIES CORPORATION AND/OR ITS AFFILIATE(S) DISCLAIM ALL WARRANTIES WITH RESPECT TO THIS DOCUMENT,
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-
INFRINGEMENT. TO THE EXTENT ALLOWED BY LAW, IN NO EVENT SHALL LIFE TECHNOLOGIES AND/OR ITS AFFILIATE(S) BE LIABLE, WHETHER IN
CONTRACT, TORT, WARRANTY, OR UNDER ANY STATUTE OR ON ANY OTHER BASIS FOR SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE OR
CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM THIS DOCUMENT, INCLUDING BUT NOT LIMITED TO THE USE THEREOF.

TRADEMARKS

The trademarks mentioned herein are the property of Life Technologies Corporation and/or their affiliate(s) or their respective owners.
TagMan and AmpliTaq Gold are registered trademarks of Roche Molecular Systems, Inc. TagMan is used under permission and license.
Microsoft, Windows and Windows Vista are registered trademarks of Microsoft Corporation.

Minitab is a registered trademark of Minitab, Inc.

Mac OS is a registered trademark of Apple, Inc.

© 2012 Life Technologies Corporation. All rights reserved.



Contents

About ThisGuide ........couii i i e 9
REVISION NS Omy L o oo 9
PUIPOSE oo 9
B CHAPTER T OVeIVIEW ...ttt i e e e e eaaeans 11
ProdUCt OVerVIEW .o 1
PUIPOSE . . oo [
Product description . . ... oo 11
AboUt the Primers ... e (K
Lociamplified by the Kit .. ... 12
Allelic ladder profile . ... ..o e 12
Control DNA OO7 profile .. ... oo e 14
WOrK L OW OVEIVIEW . o o 15
Instrument and software OVErVIEW . ... ... ... it 16
Data Collection and GeneMapper® ID or ID-X Software ..............c.ccoiiiiiiiin... 16
Instrument and software compatibility ............. . 16
About multicomponent @analysis .. ... 16

How multicomponent analysis Works . ........ ... 16
Materials and equUipmMENt .. ... o 18
Kitcontentsand storage ............ o i 18
Standards for samples ... ... 18

B CHAPTER 2 Perform PCR ...... ..ot 19
Required user-supplied reagents . ... ... i 19
DNA quantification . ... ... o 19
Importance of quantification ... ... .. 19
Methods of quantifying DNA .. ... 20
Prepare the amplification kit reactions . ... 21
Perform PCR . 22
B CHAPTER 3 Perform Electrophoresis ................. ... ...t 23
Allelic ladder requirements . ... o o e 23
Section 3.1 3100/3100-Avant and 3130/3130xlinstruments ....................... 25
Set up the 3100/3100-Avant or 3130/3130x( instrument for electrophoresis .................. 25
Reagents and parts . ... ... o i 25
Electrophoresis software setup and reference documents ................ ... ... ..., 25
Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130xl instrument . . ... .. 26

AmpFISTR® Yfiler® PCR Amplification Kit User Guide 3



Contents

Section 3.2 3500/3500xL Series instruments ..............c..oiiiiiiii 27
Set up the 3500/3500xL instrument for electrophoresis .......... ... ... o i 27
Reagents and parts . ... ... o e 27
Electrophoresis software setup and reference documents ..., 27
Prepare samples for electrophoresis on the 3500/3500xL instrument ....................... 27
Section 3.3 310 Instrument ... .. e 29
Set up the 310 instrument for electrophoresis ......... ... o i i i i 29
Reagents and parts . ... ... i i e 29
Electrophoresis software setup and reference documents .. ... ... 29
Prepare samples for electrophoresis on the 310 instrument . ........ ... .. ... ... ... ... .. 29
CHAPTER 4 AnalyzeData ............coiiiiiiiiiiii i i 31
Section 4.1 GeneMapper® /D Software ...t 31
Overview of GeneMapper® ID Software ......... ... ittt 31
NSt UM NS o oo e 31
Before you start ... ... 32
Set up GeneMapper® ID Software for dataanalysis . ... 32
File names ..o o e 32
Before using the software for the firsttime ....... ... .. L 32
Import panels and bins ... ... .. e 33
Create ananalysis method ... o i e 37
Generaltab settings . .. ... e 38
Allele tab settings . . .. ..o e 39
Peak Detectortab settings . ...... ... e 40
Peak Quality tab settings . . ... .. o 41
Quality Flags tab settings ........ .. 42
Create size standard ....... ... i e 42
Analyze and edit sample files with GeneMapper® /D Software .............. ... ... ... ..... A
Examine and edit a project . ... ... 45
Formore information .. ... o e 46
Section 4.2 GeneMapper® ID-XSoftware .............. ... . . 48
Overview of GeneMapper® ID-XSoftware ......... ... .ot 48
NS rUM NS .« . 48
Before you start ... ... 48
Set up GeneMapper® ID-X Software for dataanalysis ............. ... i 49
Panel, bin, and stutter file Version . ... 49
Before using the software for the firsttime ... . ... . L 49
Formore information .. ... ... 49
Check panel, bin, and stutter file version ........... ... . . . 50
Import panels, bins, and marker stutter ........ ... . 50
Create ananalysismethod ... ... 55
Generaltab settings . .. ... 56

AmpFISTR® Yfiler® PCR Amplification Kit User Guide



Contents

Allele tab settings . ... o o 57
Peak Detectortab settings ... ... .. e 58
Peak Quality tab settings .. ... ... 59
SQ&GQtab settings .. ... 60
Create size standard . ... 60
Analyze and edit sample files with GeneMapper® ID-X Software ............................ 62
Examine and edit @ project ... ... 63
Formore information . . ... b4
B CHAPTERS5 ExperimentsandResults ........................... 65
Section 5.1 Developmental Validation .......... ... .. ... . . 66
0= T 66
Importance of validation . ... ... .. 66
Experiment conditions . ... ... . 66
Developmental validation . ... . 67
SWGDAM Guideline 1.2, 1 .. o 67
SWGDAM Guideline 2.1.0.1 . 67

PCR COMPONENES . . .ot e e e e e e 67
Thermal cycler parameters . . ... e 67

PCR cycle NUMDEr . ..o 68
Accuracy, precision, and reproducibility ......... ... 69
SWGDAM Guideline 2.9 ..o o 69
Precision and size WINAOWS . ... ... oo 70
Extra Peaks in the electropherogram . ... ... 76
Causes of extra peaks . ........oiui i 76
Stutter products . . ... 76
Addition Of 37 A L 78

A o ) £ 79
Characterization of loCi ... ...t 80
SWGDAM Guideling 2.1 .. 80
Nature of the polymorphisms . ... .. 80

IR eI ANCE . . 81
MaPPINg oo 81
SpeCies SPECIiCItY ... e 81
SWGDAM Guideline 2.2 ... . 81
SN IV o 83
SWGDAM Guideline 2.3 ... o e 83
Effect of DNA quantity on results and importance of quantitation ...................... 83

15 =1 11 12 84
SWGDAM Guideline 2.4 ... o e 84
Lack of amplification of some loci ... ... . 84
Effect of inhibitors .. ... 84
Degraded DNA . ..o o e 85

AmpFISTR® Yfiler® PCR Amplification Kit User Guide 5



Contents

Mixture StUdIES . . ..o e 86
SWGDAM Guideline 2.8 ... e 86
Male/female mixture studies ........ ..o 86
Male/male mixture studies .. ... ... ..ot 87

Population data ... ... 88
SWGEDAM Guideling 2.7 . ..o 88
OVBIVIBW .« e ettt e e e 88
Population samples used in these studies . ....... ... 89
Gene diversity values .. ... ... e 89
Analyzing the populationdata ........... . 89

MUtation rate . ... e 90

Section 5.2 Performance Validation After Buffer and Enzyme

Component Replacement ... ... 92
D BV W L et 92
EXpErimeENts 92
Reproducibility study . . ... ..o e 93
Intracolor balance . ... . o 93
Stutter percentages . .. ... ... 93
Y ] =T o € 94
SenSItiVIty StUAY . ..o 95
Mean referenced peak height .. ... ... 95
DNA concentration and peak height . ... .. ... 96
Allelic dropoUt . ..o e 96
Genotype CONCOMdaNCE ... ittt e 98
INhibition StUdy . . ..o 98
Mean referenced peak height, minimum referenced peak height, and intracolor balance .. 98
Allelic dropoUt . . ..o 101
CONCIUSIONS e 101
APPENDIX A Troubleshooting ..., 103
APPENDIX B Ordering Information ............................ 105
Equipment and materials notincluded ........ ... ... e 105
APPENDIXC PCRWork Areas .........ccoiiiiiiiiiinnnnnnnnnnn 109
Work area setup and labdesign . ... ... e 109
PCR SetUp WOrK @rea . ...ttt e e e e e e 109
Amplified DNAWOIK area . . ... ..o e 110
APPENDIXD Safety .......ccoviiiiii i 111
Chemical safety ... 112
Biological hazard safety ....... .. .. . 112

AmpFISTR® Yfiler® PCR Amplification Kit User Guide



Contents

Documentationand Support ....... ... i e 115
Related documentation . ... ... oo i 115
Obtain SDSS . . vt 116
Obtain SUPPOIt ..ot 116
Limited Product Warranty . ... 117
Bibliography ... e 119
T 1= G 123

AmpFISTR® Yfiler® PCR Amplification Kit User Guide 7



Contents

8 AmpFISTR® Yfiler® PCR Amplification Kit User Guide



About This Guide

IMPORTANT! Before using this product, read and understand the information the
“Safety” appendix in this document.

Revision history

Revision Date Description
A November 2004 New document.
B June 2005 -
C August 2006 —
D September 2010 —
E April 2011 Change to limited licensing information.
F March 2012 Change to limited licensing information.
G August 2012 e Remove Mac 0S® procedures.

e Add 3100, 3100-Avant, 3130, 3130x., 3500,
3500xL Genetic Analyzer information. Added
GeneMapper® /D Software and GeneMapper®
ID-X Software information.

¢ Add validation experiments and results for
buffer and enzyme kit component changes.

H September 2012 Correct PCR final extension time error in rev G.

Purpose

The AmpF(STR® Yfiler® PCR Amplification Kit User Guide provides information about
the Life Technologies instruments, chemistries, and software associated with the
AmpF(STR® Yfiler® PCR Amplification Kit.
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Overview

B Product OVEIVIEW . ..ottt e e e e e e e e 11
B OWOTKEIOW OVEIVIEW . ..ottt e e e e e 15
B Instrument and software overview . ............ i 16
B Materials and equipment ............. . i 18
Product overview
Pu rpose The AmpFlSTR® Yfiler® PCR Amplification Kit is a short tandem repeat (STR)

multiplex assay that amplifies 17 Y-STR loci in a single PCR amplification:

e “European minimal haplotype” (DYS19, DYS385a/b, DYS389I/II, DYS390,
DYS391, DYS392, DYS393).

* Scientific Working Group-DNA Analysis Methods (SWGDAM)-recommended
Y-STR panel (European minimal haplotype plus DYS438 and DYS439).

* Additional highly polymorphic loci: DYS437, DYS448, DYS456, DYS458, DYS635
(Y GATA C4), and Y GATA H4.

Product The Yfiler® Kit contains all the necessary reagents for the amplification of human
description male-specific genomic DNA.
The reagents are designed for use with the following Life Technologies instruments:

* Applied Biosystems® 3100/3100-Avant Genetic Analyzer

* Applied Biosystems® 3130/3130x! Genetic Analyzer

* Applied Biosystems® 3500/3500xL Genetic Analyzer

¢ 310 Genetic Analyzer

* GeneAmp® PCR System 9700 with the Silver 96-Well Block

* GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

*  Veriti® 96-Well Thermal Cycler

About the primers Non-nucleotide linkers are used in primer synthesis for the DYS438 and DYS456 loci.
For these primers, non-nucleotide linkers are placed between the primers and the
fluorescent dye during oligonucleotide synthesis (Butler, 2005, Grossman et al., 1994,
and Baron et al., 1996). Non-nucleotide linkers enable reproducible positioning of the
alleles to facilitate interlocus spacing. The combination of a five-dye fluorescent system
and the inclusion of non-nucleotide linkers allows for simultaneous amplification and
efficient separation of the 17 Y-STR loci during automated DNA fragment analysis.

AmpFISTR® Yfiler® PCR Amplification Kit User Guide 11



1 Overview
Product overview

Loci amplified by The following table shows the loci amplified, their chromosomal locations, and the

the kit corresponding fluorescent marker dyes. The AmpF(STR® Yfiler® Allelic Ladder is
used to genotype the analyzed samples. The alleles contained in the allelic ladder and
the genotype of the AmpF(STR® Control DNA 007 are also listed in the table.

Table 1 Yfiler® Kit loci and alleles

Locus Alleles included in AmpF(STR® Yfiler® Dye ControlDNA
designation Allelic Ladder label 007
DYS456 13, 14, 15, 16, 17, 18 6-FAM™ 15
DYS389 | 10, 11,12, 13, 14, 15 13
DYS390 18, 19, 20, 21, 22, 23, 24, 25, 26, 27 24
DYS389 I 24, 25, 26, 27, 28, 29, 30, 31, 32, 33, 34 29
DYS458 14,15, 16, 17, 18, 19, 20 vIC® 17
DYS19 10, 11,12, 13, 14, 15, 16, 17, 18, 19 15
DYS385 a/b 7,8,9,10,11,12,13, 14,15, 16, 17, 18, 19, 20, 11,14

21, 22, 23, 24, 25
DYS393 8,9, 10, 11,12, 13, 14, 15, 16 NED™ 13
DYS391 7,8,9,10, 11,12, 13 (i
DYS439 8,9, 10, 11,12, 13, 14, 15 12
DYS635 20, 21, 22, 23, 24, 25, 26 24
DYS392 7,8,9,10, 11,12, 13, 14,15, 16, 17, 18 13
Y GATA H4 8, 9,10, 11, 12,13 PET® 13
DYS437 13, 14, 15, 16, 17 15
DYS438 8,9,10, 11, 12,13 12
DYS448 17,18, 19, 20, 21, 22, 23, 24 19
Allelic ladder Figure 1 shows the allelic ladder for the Yfiler® Kit. See “Allelic ladder requirements”
profile on page 23 for information on ensuring accurate genotyping.
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Product overview

Figure 1 GeneMapper® ID-X Software plot of the AmpF(STR® Yfiler® Allelic Ladder
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1 Overview
Product overview

Control DNA 007 Figure 2 shows amplification of Control DNA 007 using the Yfiler® Kit.
profile

Figure 2 1 ng of Control DNA 007 amplified with the Yfiler® Kit and analyzed on the Applied Biosystems® 3130x! Genetic
Analyzer
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Workflow overview

Workflow overview

Perform
PCR

Perform
electro-
phoresis

l

Analyze
data

Extract
DNA

Quantify
DNA

Prepare
reactions

AmpF(STR® Yfiler® PCR Amplification Kit

Perform
PCR

sy
~7

GeneAmp® PCR System 9700 Cycler Veriti® 96-Well Thermal Cycler

) =) -
= = 3 oas-
: SNe— —
3100/3100-Avant 3130/3130x! 3500/3500xL 310 Genetic
Genetic Analyzer Genetic Analyzer Genetic Analyzer Analyzer

. &

GeneMapper® ID-X or GeneMapper® /D Software

AmpFISTR® Yfiler® PCR Amplification Kit User Guide

15




1 Overview
Instrument and software overview

Instrument and software overview
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This section provides information about the Data Collection Software versions
required to run the AmpF(STR® Yfiler® PCR Amplification Kit on specific instruments.

The Data Collection Software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the Data
Collection Software collects the data and stores it. The Data Collection Software stores
information about each sample in a sample file (.fsa), which is then analyzed by the
GeneMapper® ID or ID-X Software.

Table 2 Software specific to each instrument

Instrument Operating Data Collection Analysis software
system Software
3500/3500xL e Windows® XP 3500 Series GeneMapper® /D-X Software
o Windows Data Collection | v1.2 or higher
Vista® Software v1.0
3130/3130x! Windows® XP 3.0 » GeneMapper® ID
- Software v3.2.1
31007/3100- Windows® NT 1.1 (3100) and
Avant
1.0 [3100—Avant] ° GeneMapper® ID-X
Windows® 2000 20 Software v1.0.1 or higher
310 Windows® XP 3.1
e Windows® NT | 3.0
e Windows®
2000

T We conducted validation studies using these configurations.

Life Technologies fluorescent multi-color dye technology allows the analysis of

multiple loci, including loci that have alleles with overlapping size ranges. Alleles for
overlapping loci are distinguished by labeling locus-specific primers with different
colored dyes.

Multicomponent analysis is the process that separates the five different fluorescent dye
colors into distinct spectral components. The four dyes used in the Yfiler® Kit to label
samples are 6-FAM ", VIC®, NED™, and PET® dyes. The fifth dye, LIZ®dye, is used to
label the GeneScan™ 500 LIZ® Size Standard or the GeneScan"" 600 LIZ® Size Standard
v2.0.

Each of these fluorescent dyes emits its maximum fluorescence at a different
wavelength. During data collection on the Life Technologies instruments, the
fluorescence signals are separated by diffraction grating according to their
wavelengths and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM™ dye emits at the shortest wavelength and it is
displayed as blue, followed by the VIC® dye (green), NED"" dye (yellow), PET® dye

(red), and LIZ® dye (orange).

AmpFSTR® Yfiler® PCR Amplification Kit User Guide



Chapter 10verview 1
Instrument and software overview

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes (Figure 3).
The goal of multicomponent analysis is to correct for spectral overlap.

Figure 3 Emission spectra of the five dyes used in the AmpF(STR® Yfiler® Kit
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1 Overview
Materials and equipment

Materials and equipment

Kit contents and The AmpF(STR® Yfiler® PCR Amplification Kit (Part no. 4427368) contains materials
sto rage sufficient to perform 100 amplifications at 25 pL/amplification.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Component Description 100X Volume Storage
AmpFlSTR® Yfiler® Contains MgCl,, dNTPs, and bovine serum 1 tube, 1.1 mL -15 to -25°C on receipt,
PCR Reaction Mix albumin in buffer with 0.05% sodium azide. 2 to 8°C after initial use
AmpF(STR® Yiiler® Contains forward and reverse primers to 1 tube, 0.55 mL
Primer Set amplify human male DNA target.

AmpF(STR® Yiiler® Contains amplified alleles. 1 tube, 0.05 mL

Allelic Ladder See Table 1 on page 12 for a list of alleles

included in the allelic ladder.

AmpF(STR® Control Contains 0.10 ng/uL human male DNA in 1 tube, 0.3 mL
DNA 007 0.05% sodium azide and buffer®.

See Table 1 on page 12 for profile.
AmpF(STR® Control Contains 10 ng/pL human female DNA in 1 tube, 0.025 mL
DNA 9947A 0.05% sodium azide and buffer.

See Table 1 on page 12 for profile.

AmpliTag Gold® DNA Contains enzyme, with an activity of 5U/uL. | 2tubes, 0.05mL | -15 to -25°C
Polymerase each

+ The AmpF(STR® Control DNA 007 is included at a concentration appropriate to its intended use as an amplification control [i.e., to provide
confirmation of the capability of the kit reagents to generate a profile of expected genotype). The AmpF(STR® Control DNA 007 is not designed
to be used as a DNA quantitation control, and you may see variation from the labelled concentration when quantitating aliquots of the
AmpF(STR® Control DNA 007.

Standards for For the Yfiler® Kit, the panel of standards needed for PCR amplification, PCR product
samples sizing, and genotyping are:
e AmpF/STR® Control DNA 007 - A positive control for evaluating the efficiency

of the amplification step and STR genotyping using the AmpFéSTR® Yfiler®
Allelic Ladder.

* GeneScan"" 500 LIZ® Size Standard or GeneScan™ 600 LIZ® Size Standard
v2.0 — Used for obtaining sizing results. These standards, which have been
evaluated as internal size standards, yield precise sizing results for Yfiler® Kit
PCR products. Order the GeneScan'" 500 LIZ® Size Standard (Part no. 4322682) or
the GeneScan"" 600 LIZ® Size Standard v2.0 (Part no. 4408399) separately.

* AmpF/STR® Yfiler® Allelic Ladder — Allelic ladder developed by Life
Technologies for accurate characterization of the alleles amplified by the Yfiler®
Kit. The AmpF(STR® Yfiler® Allelic Ladder contains most of the alleles reported
for the 17 loci. Refer to Table 1 on page 12 for a list of the alleles included in the
AmpF(STR® Yfiler® Allelic Ladder.

18 AmpFISTR® Yfiler® PCR Amplification Kit User Guide



Perform PCR

Required user-supplied reagents............. ...
DNA quantification . ..................u i
Prepare the amplification kit reactions . . .......... ...

Perform PCR .. ...

Required user-supplied reagents

In addition to the Yfiler® Kit reagents, the use of low-TE buffer (10 mM Tris, 0.1 mM
EDTA, pH 8.0) is recommended. You can prepare the buffer as described in the
procedure below or order it from Teknova (Cat # T0223).

To prepare low-TE buffer:

1. Mix together:
¢ 10mL of 1 M Tris-HCI, pH 8.0
* 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.
2. Aliquot and autoclave the solutions.

3. Store at room temperature.

DNA quantification

Importance of
quantification

Quantifying the amount of DNA in a sample before amplification allows you to
determine whether or not sufficient DNA is present to permit amplification and to

calculate the optimum amount of DNA to add to the reaction. The optimum amount of

DNA for the Yfiler® Kit is 1.0 ng in a maximum input volume of 10 pL for 28 PCR
cycles.

AmpFISTR® Yfiler® PCR Amplification Kit User Guide



Perform PCR
DNA quantification

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in:

¢ Fluorescence intensity that exceeds the linear dynamic range for detection by the

instrument (“off-scale” data). Off-scale data are problematic because:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, and it results in
poor spectral separation (“pull-up”).

¢ Incomplete A-nucleotide addition.

When the total number of allele copies added to the PCR is extremely low, allelic
dropout can occur resulting in a partial profile.

Methods of
quantifying DNA

Life Technologies provides several kits for quantifying DNA in samples. See the
references cited in the following table for details about these Kkits.

Product

Description

Quantifiler® Human DNA
Quantification Kit
(Part no. 4343895)

and

Quantifiler® Y Human Male
DNA Quantification Kit
(Part no. 4343906)

For more information, see
Quantifiler® Human DNA
Quantification Kits User’s Manual
(Pub no. 4344790)

Quantifiler® Duo DNA
Quantification Kit
(Part no. 4387746)

For more information, see
Quantifiler® Duo DNA
Quantification Kit User's Manual
(Part no.4391294)

Properties:

The Quantifiler® Human and Quantifiler® Y Human Male Kits are highly specific for
human DNA, and they individually detect total human or male DNA, respectively. The
kits detect single-stranded and degraded DNA.

How they work:

The Quantifiler® DNA Quantification Kits consist of target-specific and internal control
5" nuclease assays.

The Quantifiler® Human and Quantifiler® Y Human Male Kits contain different target-
specific assays (human DNA or human male DNA, respectively] that each consist of two
locus-specific PCR primers and one TagMan® MGB probe labeled with FAM™ dye for
detecting the amplified sequence. The kits each contain a separate internal PCR control
(IPC) assay, which consists of an IPC template DNA (a synthetic sequence not found in
nature), two primers for amplifying the IPC template, and one TagMan® MGB probe
labeled with VIC® dye for detecting the amplified IPC.

Properties:

The Quantifiler® Duo Kit is highly specific for human DNA. This kit combines the
detection of both total human and male DNA in one PCR reaction.The kit detects single-
stranded and degraded DNA.

How it works:

The Quantifiler® Duo DNA Quantification Kit consists of target-specific and internal
control 5" nuclease assays.

The Quantifiler® Duo kit combines two human-specific assays in one PCR reaction (for
total human DNA and human male DNAJ. The two human DNA specific assays each
consist of two PCR primers and a TagMan® probe. The TagMan® probes for the human
DNA and human male DNA assays are labeled with VIC® and FAM™ dyes, respectively.
In addition, the kit contains an internal PCR control (IPC) assay similar in principle to
that used in the other Quantifiler kits, but labeled with NED™ dye.

20
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Prepare the amplification kit reactions

Prepare the amplification kit reactions

1.

Calculate the volume of each component needed to prepare the reactions, using
the table below.

DNA sample Volume per reaction
AmpF(STR® PCR Reaction Mix 9.2 L
AmpF(STR® Yfiler® Primer Set 5.0 L
AmpliTag Gold® DNA Polymerase 0.8 uL

Prepare reagents. Include additional reactions in your calculations to provide
excess volume for the loss that occurs during reagent transfers. Thaw the PCR
Reaction Mix and the Primer Set, then vortex all reagent tubes, including the
enzyme, for 3 seconds and centrifuge briefly before opening the tubes.

IMPORTANT! Thawing is required only during first use of the Primer Set and PCR
Reaction Mix. After first use, these reagents are stored at 2 to 8°C and, therefore,
they do not require subsequent thawing. Do not refreeze these reagents.

Prepare the master mix: Pipette the required volumes of components into an
appropriately sized polypropylene tube.

Vortex the master mix for 3 seconds, then centrifuge briefly.

Dispense 15 L of the master mix into each reaction well of a MicroAmp® Optical
96-Well Reaction Plate or each MicroAmp® tube.

Prepare the DNA samples:

DNA sample To prepare...

Negative control | Add 10 pL of low-TE buffer (10mM Tris, 0.1mM EDTA, pH 8.0).

Test sample Dilute a portion of the test DNA sample with low-TE buffer so
that 1.0 ng of total DNA is in a final volume of 10 pL. Add 10 pL
of the diluted sample to the reaction mix.

Positive control Add 10 pL of 007 control DNA (0.1 ng/uL).

The final reaction volume (sample or control plus master mix) is 25 pL.

Seal the plate with MicroAmp® Clear Adhesive Film or MicroAmp® Optical
Adhesive Film, or cap the tubes.

Centrifuge the tubes at 3000 rpm for about 20 seconds in a tabletop centrifuge
(with plate holders if using 96-well plates).

. Amplify the samples in a GeneAmp® PCR System 9700 with the silver or

gold-plated silver 96-well block or a Veriti® 96-Well Thermal Cycler.

Note: The Yfiler® Kit is not validated for use with the GeneAmp PCR System
9700 with the aluminium 96-well block. Use of this thermal cycling platform may
adversely affect performance of the Yfiler® Kit.
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Perform PCR

Perform PCR

1. Program the thermal cycling conditions:

* When using the GeneAmp® PCR System 9700 with either 96-well silver or
gold-plated silver block, select the 9600 Emulation Mode.

e When using the Veriti® 96-Well Thermal Cycler, refer to the following
document for instructions on how to configure the Veriti instrument to run
in the 9600 Emulation Mode: User Bulletin: Veriti® 96-Well Thermal Cycler
AmpF(STR® Kit Validation (Part no.4440754).

Initial Denature Anneal Extend Final Final hold
incubation step extension

HOLD CYCLE (30) HOLD HOLD

95°C 94°C 61°C 72°C 60°C 4°C o

11 min 1 min Tmin Tmin 80 min

2. Load the plate into the thermal cycler and close the heated cover.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, be sure to
place a MicroAmp® compression pad (Part no. 4312639) on top of the plate to
prevent evaporation during thermal cycling. The Veriti® Thermal Cycler does not
require a compression pad.

3. Start the run.

4. On completion of the run, store the amplified DNA and protect from light.

If you are storing the DNA... Then place at...
< 2 weeks 2 to 8°C
> 2 weeks -15to -25°C

IMPORTANT! Store the amplified products so that they are protected from light.
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Prepare samples for electrophoresis on the 3500/3500xL instrument. ......... 27
B Section3.3 310Instrument.......... ... ... 29
Set up the 310 instrument for electrophoresis . ............................ 29
Prepare samples for electrophoresis on the 310 instrument ................. 29

Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples.

Number of allelic . _Ong Number of samples per
Instrument injection .
ladders to run equals allelic ladder(s)

3100-Avant or 3130 | 1 per 4 injections 4 samples 15 samples + 1 allelic ladder

3100 or 3130x{ 1 per injection 16 samples | 15 samples + 1 allelic ladder
3500 1 per 3 injections 8 samples 23 samples + 1 allelic ladder
3500xL 1 per injection 24 samples | 23 samples + 1 allelic ladder
310 1 per 10 injections | 1sample 9 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between both single- and multiple-capillary runs
(with larger size variations seen between samples injected in multiple-capillary runs).
We recommend the above frequency of allelic ladder injections, which should account
for normal variation in run speed. However, during internal validation studies, verify
the required allelic ladder injection frequency to ensure accurate genotyping of all
samples in your laboratory environment.
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Allelic ladder requirements

It is critical to genotype using an allelic ladder run under the same conditions as the
samples because size values obtained for the same sample can differ between
instrument platforms because of different polymer matrices and electrophoretic
conditions.
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Section 3.1 3100/3100-Avant and 3130/3130xl instruments
Set up the 3100/3100-Avant or 3130/3130x! instrument for electrophoresis

Section 3.1 3100/3100-Avant and 3130/3130x!

instruments

Set up the 3100/3100-Avant or 3130/3130x! instrument for

electrophoresis

Reagents and parts

AmpFlSTR® Yfiler® PCR Amplification Kit.

“Ordering Information” on page 105 lists the required materials not supplied with the

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Electrophoresis
software setup and
reference

The following table lists Data Collection Software and the run modules that can be
used to analyze Yfiler® Kit PCR products. For details on the procedures, refer to the
documents listed in the table.

documents
Genetic Data Operatin
Collection P 9 Run modules and conditions References
Analyzer System
Software
Applied 3.0 Windows® ¢ HIDFragmentAnalysis36_POP4_1 | Applied Biosystems 3130/3130xl
Biosystems® XP Injection conditions: Genetic Analyzers Using Data
3130/3130x! 3130 = 3 kV/5 sec Collection Software v3.0, Protocols for
Processing AmpF(STR® PCR
~ 3130x( = 3 kV/10 sec Amplification Kit PCR Products User
e Dye Set G5 Bulletin (Pub no. 4363787)
31007 2.0 Windows® e HIDFragmentAnalysis36_POP4_1  3100/3100-Avant Genetic Analyzers
2000 Injection condition: 3kV/10 sec Using Data Collection Software v2.0,
e Dve Set G5 Protocols for Processing AmpF(STR®
y PCR Amplification Kit PCR Products
User Bulletin (Pub no. 4350218)
1.1 Windows® ¢ GeneScan3évb_DyeSetG5Module 3100/3100-Avant Genetic Analyzers
NT Injection condition: 3kV/10 sec Protocols for Processing AmpFISTR®
R . PCR Amplification Kit PCR Products
G5600v20Analysis.gsp User Bulletin (Pub no. 4332345)
3100-Avant 1.0 Windows® e GeneScan36Avb_DyeSetG5Module = 3700/3100-Avant Genetic Analyzers
NT Protocols for Processing AmpF(STR®

Injection condition: 3 kV/5sec
GS600v2.0Analysis.gsp

PCR Amplification Kit PCR Products
User Bulletin (Pub no. 4332345)

T We conducted validation studies using these configurations.

AmpFISTR® Yfiler® PCR Amplification Kit User Guide
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Chapter 3 Perform Electrophoresis
Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130x! instrument

Prepare samples for electrophoresis on the 3100/3100-Avant or
3130/3130x! instrument

26

Prepare the samples for electrophoresis immediately before loading.

1.

Calculate the volume of Hi-Di'" Formamide and size standard needed to prepare
the samples:

e © ® =2 o

Reagent Volume_ per Reagent Volume_ per
reaction reaction
GeneScan™ 500 0.3 L OR GeneScan™ 600 0.5 pL
LIZ® Size Standard LIZ® Size Standard
v2.0
Hi-Di™ Formamide 8.7 uL Hi-Di™ Formamide 8.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

Pipette the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.
Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:

* 9 uL of the formamide:size standard mixture
¢ 1 pL of PCR product or allelic ladder
Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

Seal the reaction plate with appropriate septa, then centrifuge the plate to ensure
that the contents of each well are collected at the bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.

Prepare the plate assembly, then place on the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

Start the electrophoresis run.
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Set up the 3500/3500xL instrument for electrophoresis

Section 3.2 3500/3500xL Series instruments

Set up the 3500/3500xL instrument for electrophoresis

Reagents and parts  “Ordering Information” on page 105 lists the required materials not supplied with the
AmpF(STR® Yfiler® PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.
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Electrophoresis The following table lists Data Collection Software and the run modules that can be
software setup and used to analyze Yfiler® Kit PCR products. For details on the procedures, refer to the
documents listed in the table.

reference
documents
Genetic Data Operatin
Collection P 9 Run modules and conditions References
Analyzer System
Software
Applied 3500 Data | Windows® e HID36_POP4 Applied Biosystems® 3500/3500xL
Biosystems® | Collection | XP Injection conditions: 1.2kV/15 sec = Genetic Analyzer User Guide
3500 Software (Pub no. 4401661)
1.0 or ¢ Dye Set G5
. ; ; ®
Applied Windows e HID36_POP4 Applied Biosystems™ 3500 and
Biosystems® Vista ® Injection conditions: 1.2kV/24 sec 3500 Genetic Analyzers Quick
3500xL. ) o Reference Card (Pub no. 4401662)
e Dye Set G5

Prepare samples for electrophoresis on the 3500/3500xL
instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di™ Formamide and GeneScan™ 600 LIZ® Size
Standard v2.0 needed to prepare the samples:

Reagent Volume per reaction
GeneScan™ 600 LIZ® Size Standard v2.0 0.5 pL
Hi-Di™ Formamide 8.5 L

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.
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Prepare samples for electrophoresis on the 3500/3500xL instrument

e © ®©® =2 o

Pipette the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.

Into each well of a MicroAmp® Optical 96-Well Reaction Plate, or each
MicroAmp® optical strip tube, add:

* 9 uL of the formamide:size standard mixture
* 1 uL of PCR product or allelic ladder
Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

Seal the reaction plate or strip tubes with the appropriate septa, then centrifuge to
ensure that the contents of each well are collected at the bottom.

Heat the reaction plate or strip tubes in a thermal cycler for 3 minutes at 95°C.
Immediately put the plate or strip tubes on ice for 3 minutes.

Prepare the plate assembly, then place on the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

Start the electrophoresis run.
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Set up the 310 instrument for electrophoresis

Section 3.3 310 Instrument

Set up the 310 instrument for electrophoresis

Reagents and parts  “Ordering Information” on page 105 lists the required materials not supplied with the
AmpF(STR® Yfiler® PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.
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Electrophoresis The following table lists Data Collection Software and the run modules that can be
software setup and used to analyze Yfiler® Kit PCR products. For details on the procedures, refer to the
documents listed in the table.

reference
documents
Data Operatin
Collection P 9 Run modules and conditions References
System
Software
3.1 Windows® e GS STR POP4 (1mL) G5 v2.md5 = 370 Genetic Analyzer User’s Manual (Windows]
or XP Injection condition: (Pub no. 4317588)
3.0 or 15 kV/5 sec 310 Protocols for Processing AmpFISTR® PCR
Windows® Amplification Kit Products with Microsoft Windows
NT and NT Operating System: User Bulletin
Windows® (Pub no. 4341742)
2000

Prepare samples for electrophoresis on the 310 instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di"" Formamide and size standard needed to prepare
the samples:

Reagent Volume per reaction
GeneScan™ 500 LIZ® Size Standard or 0.75 pL
GeneScan™ 600 LIZ® Size Standard v2.0
Hi-Di™ Formamide 24.5 ul

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.
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Prepare samples for electrophoresis on the 310 instrument

2. Pipette the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each 0.2 mL sample tube, add:
e 25 uL of the formamide:size standard mixture
¢ 1.5 pL of PCR product or allelic ladder
Note: For blank wells, add 25 uL of Hi-Di"" Formamide.

5. Seal the tubes with the appropriate septa, then briefly centrifuge to ensure that
the contents of each tube are mixed and collected at the bottom.

Heat the tubes in a thermal cycler for 3 minutes at 95°C.
Immediately place the tubes on ice for 3 minutes.
Place the sample tray on the autosampler.

Ensure that an injection list is prepared.

© ® ® N o

Start the electrophoresis run.
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Section 4.1 GeneMapper® ID Software

Overview of GeneMapper® /D Software

GeneMapper® ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample
in a .fsa file. Using GeneMapper® ID Software v3.2.1 software, you can then analyze
and interpret the data from the .fsa files.

Instruments Refer to “Instrument and software overview” on page 16 for a list of compatible
instruments.
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Set up GeneMapper® ID Software for data analysis

Before you start

When using GeneMapper® ID Software v3.2.1 to perform human identification (HID)
analysis with AmpF(STR® kits, be aware that:

HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID Software calculates allelic bin
offsets by using an average of all ladders that use the same panel within a run
folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.

Set up GeneMapper® ID Software for data analysis

File names

Before using the
software for the
first time

32

The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper®
ID Software.

Before you can analyze sample (.fsa) files using GeneMapper® ID Software v3.2.1 for
the first time, you need to:

Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” on page 33.

Create an analysis method, as explained in, “Create an analysis method” on page
37.

Create a size standard, as explained in “Create size standard” on page 42.

Define custom views of analysis tables.

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (Pub no. 4335523) for more information.

Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (Pub no. 4335523) for more information.
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Set up GeneMapper® ID Software for data analysis

Import panels and  To import the Yfiler® panel and bin set into the GeneMapper® ID Software v3.2.1
bins database:

1. Start the GeneMapper® ID Software, then log in with the appropriate user name
and password.

IMPORTANT! If you need logon instructions, refer to page 2-7 of the GeneMapper®
ID Software Version 3.1 Human ldentification Analysis User Guide (Pub no. 4338775).

2. Select Tools » Panel Manager.

3. Find, then open the folder containing the panels and bins:

a. Select Panel Manager in the navigation pane.

(] Panel Manager

File Edit Bins View

=) NN .I.I.IlE:ins.at:

B Panel Manager |

)
()
>
()
=
[
O
O
g
<)
)
w
o
=
=
(V)
=
()

Highlight this.
|

b. Select File » Import Panels to open the Import Panels dialog box.

c. Navigate to, then open the x:\ Applied Biosystems\ GeneMapper\ Panels
folder, where x is the drive on which the GeneMapper® ID Software is
installed.

4. Select AmpFLSTR_Yfiler_Panel_v2.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager, AmpFLSTR_Yfiler_Panel_v2. This folder contains the panels and
associated markers.

() Import Panels

Look in: |@Panels V| I ,5||E|

L [Z] AmpFLETR_Binz_v1 txt
L"sb [Z] smpFLSTR_Bins_v2 txt
My Recent @ AmpFLSTR_Panels_w txt
Documents [Z] AmpFLETR_Panels_w2 txt
AmpFISTR_Yfiler _Bin_w2 txt
| aFIS iler_Par >

é! File name: | AmpFISTR_Yfiler_Panel_v2 txt |
My Computer | Files of type: |AII Files v | Cancel
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5. Import AmpFLSTR_Yfiler_Bins_v2.txt:
a. Select the AmpFLSTR_Yfiler_Panel_v2 folder in the navigation pane.

[#) Panel Manager

File Edit Bins View
HF X W W W [ BinSet: |AmpFLSTR viiler_Binset_v2 v| |||[ B

= EPanel Manager Panel Hame Clom
T &mpFLSTR _Panets_v1 1 |1’fi|er_v2 ||n0n

|jAmpFLSTR_MiniFiIer_GSSDD_PaneIS_v1
IjAmpFLSTR_SEfiIer_PIus_PaneIs_v1

[ &mpFLSTR Panels_v2
IjAmpFLSTR_IdentifiIer_PIus_w
[TidertifilerDirect_GS500_v1
W AmpFLSTR_Yfiler_Panel_v2
[ &mpFLSTR_MGH_v2

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to, then open the x:\ Applied Biosystems\ GeneMapper\ Panels
folder.
d. Select AmpFLSTR_Yfiler_Bins_v2.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AmpFLSTR_Yfiler_Panel_v2 folder.

(#) Import Bin Set

Look in: |@ Panelz V| I ’_*!||E|
Y [Z] AmpFLETR_ Bins_v1 txt
;3 [Z] AmpFLETR_ Bins_v2 txt

My Recent E] AmpFLSTR_Panels_w txt

Documents [Z] AmpFLETR_Panels_w2 txt
mpFIST
E] AmpFISTR_Yfiler _Panel_v2 txt

My D rts
VRREUMENE | Fie rame: [ mpFISTR viler_Bin_v2 bt |
g_! Filez of type: |AII Files w | Cancel
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6. View the imported panels in the navigation pane:
a. Double-click the AmpFLSTR_Yfiler_Panel_v2 folder.

b. Double-click the Yfiler_v2 folder to display the panel information in the
right pane and the markers below it.

Panel Manager

File Edit Bins View
B EEE M snse |AmpFLSTR_YfiIer_Binset_vz v| R RN |.|.|Q|. g)
B EIPanel Marager - Maker Hane  |Dye Color | Min Sise |Mx Sime | Comtrol Alleles jy 8
LT AmpFLETR_Panels_1 1 |B_pvs4se  |wwe 1000|1270 |15 4 2
gAmpFLSTR_MiniFiIer_GSSDD_PaneIS_v1 2 |B_Dvs3sal hiue 134.0 1780 13 4 %
AmpFLSTR_SEfiler_Plus_Panels_w1 o
T = B_DVS390 |l 1850  |2450 |24 4
] AmpFLSTR_Panels_vz2 2 {07 e @
IjAmpFLSTR_IdentifiIer_PIus_w 4 |B_DYS35410 blue 2460 3020 29 4 )
[CicentifilerDirect_GS500_1 5 |G_Dvs4s8  |green [1330  [1850 |17 4 S
= EDAmpFLSTR filer_Parel_v2 & |G_DYs19 green 1670|2190 |15 4 o
= o
e 7 |G_Dvs3e5  |green |2350  |3230  [1114 4 S
B Dvsasal & |v_DvS393  |yelow [1040  [1440 |13 4 s
B_DYS390 a |v_Dvs3e1  |yelow [1460 1810 |11 4 %
B_DYS3831 10 |¥_DvS439  |yelow [1920 2380 |12 4
G_Dvs458
i 11 |v_DvsEas  |yelow |2410  |2740 |24 4
& Dys3as 12 |v_Dvs3e2  |yelow |2860 |33s0 |13 3
¥_DY5393 13 |R_v_GATA_H4|red 1140 [1300 |13 4
¥ _bvE3st 14 [R_DVS437  |red 1740  |2100 |15 4
¥_Div5439
o 15 |R_D¥S438  |red 2155 |2565 |12 5
- 16 |R_DvS448  |red 2730|3320 |19 &
R_Y_GATA_H4 <
R_DVS437
R_DVS438 B
R_DVS443 v
=IReference Samples ‘
[ Ok H Cancel H Apply ]

7. View the markers and display the Bin view in the navigation pane:

a. Select the AmpFLSTR_Yfiler Panel v2 folder to display its list of kits in the
right pane.

b. Double-click the Yfiler_v2 folder to display its list of markers below it.
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c. Select B_DYS389II to display the Bin view for the marker in the right pane.

File Edit Bins View

B X B m W (B Binset: |ampFLSTR_Yiier_Binset vz v| 1M ] ] |i|i|_|i|. |

= EJPanel Manager -~
[C]4mpFLSTR_Pansls_1 za| 28] 26 [27] 28] [20] [30| [31] =2 |33 (34
[T &mpFLSTR MiniFiler_GS500_Panels_w1 1.0
IjAmpFLSTR_SEfiIer_PIus_PaneIs_v1
[ &mpFLSTR Panels_v2
IjAmpFLSTR_IdentifiIer_PIus_w
[idertifilerDirect_GS500_w1
ﬁAmpFLSTR_YfiIer_PaneI_v2
= ESrviler_v2

B_D%'S436

B_D%'S3891

0 H & EEEE

E_Dvs390

G_DYS458
G_DYs1g
G_DYS385
¥ _DYS393
¥ _Dvsag
¥ _DYS439
¥ _DYSEIS
¥ _DYS302
R_¥_GATA_He i
R_DYS437 241 247 253 259 265 271 277 283 280 205 a1 a07
R_DYS438
R_DYS445 v
e ‘i B3

B_Dvrs3aall

=IReference Samples

[ Ok H Cancel H Apply ]

8. Click Apply, then OK to add the AmpF/STR® panel and bin set to the
GeneMapper® ID Software database.

IMPORTANT! If you close the Panel Manager without clicking OK, the panels and
bins are not imported into the GeneMapper® ID Software database.
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Create an analysis The HID Advanced analysis method for the Yfiler® Kit uses the
method AmpFLSTR_Yfiler_Bins_v2 file described in step 5 on page 34.

Use the following procedure to create a HID analysis method for the Yfiler® Kit.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

(7] GeneMapper Manager

| Takle Settings || Plat Settings | Matrices | Size Standards

Mame Last Saved Cavner Instrument Analysis Type Dezcription
IertifilerDirect_HID_w1 2010-05-05 10:24:1 | gnicd HIC Default Identifier O |
Idertifiler_Plus_Analysiztlet |2011-05-19 14:41:1 | gnicd HID Default aralysis
Microzatellite Defaut 2010-01-27 14:58:0 | grnid Microzastelite Factory Provided 2
< Y

ey .. Open... Save Az . Expart... Delete

2. Select the Analysis Methods tab, then click New to open the New Analysis
Method dialog box.

3. Select HID and click OK to open the Analysis Method Editor with the General
Tab selected.

4. The figures below show the settings for each tab of the Analysis Method Editor.
Configure settings as shown unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

5. After you enter settings in all tabs, click Save.
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Set up GeneMapper® ID Software for data analysis

General tab

. Analysis Method Editor - HID '
settings S X
| General | allete || Peak Detector | Peak Qualty | cusity Flags |
~&nalysis Method Description
Hame: | ‘iler_srialysishethac_2] |
Description: ~
W
Instrument:
Analysis Type: HID
[ Ok ] [ Cancel ]

In the Name field, either type the name as shown, or enter a name of your choosing.
The Description and Instrument fields are optional.
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Allele tab settings

Analysis Method Editor - HID

| General | Allele | Pesk Detectar | Peak Guality | Quslity Flags

[SIgR=t= i At FLS TR Y filer_Binzet_w2
Use marker-specific stutter ratio it available
Marker Repesat Type Ti Tetra Perita Hexa ®
Cut-off Yalue on on an an g
Minus4, Ratio oo oo 0.0 0.0 %
Minuz4 Distance From |00 0o [uli} 0.0 §
To |00 0o 0o 0o ‘-'i@
Minuz Stutter Fatio oo oa pi] oo 5
Minus Stutter Distance From oo 325 oo [In] g)
=
To oa 475 0.0 0.0 g
Plus Stutter Ratio oo oo 0.0 0.0 %
Pluz Stutter Distance From |00 0o oo [uli}
To oo oo 0.0 0.0
Arnelogenin Cutoff

Range Filter ... [ Factory Defaults ]

[ [ cmen |

* In the Bin Set field, select the AmpFLSTR_Yfiler_Bins_v2 bin set imported
previously and configure the stutter distance parameters as shown.

* GeneMapper® ID Software v3.2.1 allows you to specify four types of marker
repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values for each
type of repeat in the appropriate column.

* Specify the stutter ratio:

— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for
single-source sample data.

— To apply the stutter ratios contained in the AmpFLSTR_Yfiler_Panel_v2.txt
file, select the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.
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Peak Detector tab

X

Analysis Method Editor - HID

settings
General | Allele | Peak Detector | Peak Quality | Quality Flags
Peak Detection Algorithm: |&dvanced w
Ranges Peak Detection
Analysis Sizing Peak Amplitude Thresholds: 5]?;’?::'1
Full Range  + All Sizes hd . . N .
B: |50 R |50 validation
G: |50 0: |50 studies to
determine
v |50 settings
—=mocthing and Baselining
Mir. Peak Half Wicth: 2 pts
Smoathing ) None ) 5
@ Light Palynamial Degree:
) Heavy Peak Windaw Size: 15 pts
Baszeline Windawy: | 51 pt= Slope Threshold
Peak Start: 0o
—=ize Calling Method Pesk End: oo

() 2nd Order Least Sguares
(:) 3rd Order Least Sguares
() Cubic Spline Interpolation
(%) Local Southern Method
() Global Southern Method

[ Factory Defaults ]

ok | [ comeet |

IMPORTANT! Perform the appropriate internal validation studies to determine the
peak amplitude thresholds for interpretation of Yfiler® Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper® ID Software displays peaks that fall below the specified amplitude
in electropherograms, the software does not label or determine the genotype of

these peaks.

¢ Size calling method - The Yfiler® Kit has been validated using the Local
Southern sizing method. Select alternative sizing methods only after performing
the appropriate internal validation studies.
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Peak Quality tab

settings Analysis Method Editor - HID
| General | Allele | Peak Detector | Peak Quality | Qualty Flags |
—Signal level N\ Perform
Homozygous min pesk height I:I int?(;n?l
) . vallgation
Heterozygous min peak height I:I studies to
~Heterozyoote balance determine

settings
Min peak height ratio / 9

—Peak rmorphalogy
Mz peak width (bazepairs)

Pull-up peak
Pull-up ratio 0.0s

)
()
>
()
=
[
O
O
g
<)
)
w
o
=
=
(V)
=
()

~Allele number

Max expected aleles

’ Factory Defaults ]

(o | [ coment |

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds and the
minimum peak height ratio threshold for interpretation of Yfiler® Kit data.
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Quality Flags tab

x]

settings Analysis Method Editor - HID
General | Allele | Peak Detector | Peak Quality | Quality Flags
Guality weights are betvween 0 and 1.
—Gwalty Flag Setings
Spectral Pull-up 0& Control Concordance 1.0
Broad Peak 0a Loy Peak Height 03
Out of Bin Allele 08 Off-scale D8
Evizileg o0& Peak Height Ratio 0.3
PO Thresholds
Pass Range: Lowy Guality Range:
Sizing Guslity: From | 073 to1.0 From0.0to | 025
Genatype Guality: From | 0.75 lo1.0 From0.0to | 0.25
Factory Defaults
’ Ok I ’ Cancel I
IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform the appropriate internal validation studies
to determine the appropriate values for interpretation of Yfiler® Kit data.
Create size The size standards for the Yfiler® Kit use the following size standard peaks in their

GeneScan™ 500 LIZ® Size Standard peak = GeneScan™ 600 LIZ® Size Standard v2.0

sizes peak sizes
75, 100, 139, 150, 160, 200, 300, 340, 350, 400, | 80, 100, 114, 120, 140, 160, 180, 200, 214, 220,
and 450 240, 250, 260, 280, 300, 314, 320, 340, 340,

380, 400, 414, 420, 440 and 460

Note: The 250-nt peak in the GeneScan™" 500 LIZ® Size Standard is not included in the
size standard definition. This peak can be used as an indicator of precision within a
run.

Use the following procedure to create the appropriate size standard:

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
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2. Select the Size Standards tab, click New, select the Basic or Advanced radio
button, then click OK.

() GeneMapper Manager

| Projects | Analysis Methods | Table Settings | Piot Settings | Meatrices | Size Standards
Mame Last Saved Cravner Type Dezcription
| CE_55_HID_GS500 2010-09-05 15:04:3 | gid Basic/sdvanced |_:J

S Open... Save As.. Expaort... Delste

3. Enter a name (for example, CE_G5_Yfiler_GS500 as shown below). In the Size
Standard Dye field, select Orange. In the Size Standard Table, enter the sizes
specified in on page 42. The example below is for the GeneScan'" 500 LIZ® Size
Standard.

)
()
>
()
=
[
O
O
g
<)
)
w
o
=
=
(V)
=
()

Marmne; CE_GS_Yfiler_GS500
Size Standard Dye: Crange w
Size Standard Table

|Size in Basepairs
'I_I?'S.B ~

2 1000
I3 [1390

4 1500

5 |[1600

6 [2000
7 |a000
& 3400
la 3500

10 [a00.0

[x

AmpFISTR® Yfiler® PCR Amplification Kit User Guide 43



4 Chapter 4 Analyze Data
Analyze and edit sample files with GeneMapper® ID Software

Analyze and edit sample files with GeneMapper® ID Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter

Settings

Sample Type
Analysis Method

Panel

Size Standard

Select the sample type.

Yfiler_AnalysisMethod_v2 (or the name of the analysis method
you created)

Yfiler_v2

CE_G5_Yfiler_GS500% (or the name of the size standard you
created)

+ The Yfiler® Kit was originally validated using the GeneScan™ 500 LIZ® Size Standard. If you use the
GeneScan™ 600 LIZ® Size Standard v2.0 as an alternative, perform the appropriate internal validation
studies to support the use of this size standard with the Yfiler® Kit.

Note: For more information about how the Size Caller works, refer to the
GeneScan® Analysis Software for the Windows NT® Operating System Overview of the
Analysis Parameters and Size Caller User Bulletin (Pub no. 4335617).

3. Click B (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

¢ The status bar displays the progress of analysis:

— As a completion bar extending to the right with the percentage

indicated

— With text messages on the left

44
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Examine and edit a project

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Genotypes tab becomes available after analysis (see the figure on the
next page).

Project window after analysis

(7] GeneMapper ID v3.2.1 - *Untitled - gmid Is Logged In

File Edit Analysis View Tools Help
ted BE BN ju B @  TablesSeting  AwpFLSTR Table v|m 58S =
= SProject Samples i &=
® ([ vfiler Example Status | Sample File Sample Type | Analysis Method Panel |Size Standard [Run Name
1 I, Allelic Ladder fsa |Allelic Ladder Wiiler_snalysishethod_ | filer_v2 CE_GS_Yfiler_GS500
2 h Sample 1.1sa Posttive Cortrol | Yfiler_Analysishdethod_ Yfiler_v2 CE_G5_Yfiler_GS500
3 s, Sample 10.fsa  |Negative Contral |Vfiler_Analysistdethod_ Yfiler_v2 CE_GS_Yfiler_GS500
4 v Sample 11.fsa | Sample Yfiler _Analysishethod_ | Y filer_v2 CE_GS_filer_GS500
5 3 Sample 12.fza  |Sample Viiler_Analysishethod_ | filer_v2 E_GS_Yfiler_GSS00
6 I Sample 13.fsa  |Sample Yfiler _Analysishethod_ | filer_v2 CE_GS_Yfiler_35500
7 [ 3 Sample 2.fsa Sample Y filer_Analysishethod_ | filer_v2 CE_GS_Yfiler_GS500
8 h Satnple 3.1za Sarnple Yiler_Analysishethod_ | filer_v2 CE_G5_Yfiler_GS500
4 h Sample 4.1za Sample Yfiler_Analysishethod_ | filer_v2 CE_(5_Yfiler_GS500
10 I (Samplesisa  [Sample Yiler_Analysishethod_ | filer_v2 CE_GS_Yfiler_GS500
11 h Sample 6.1za Sample Yiler_snalysishethod_ | 'Y filer_v2 CE_G5_Yfiler_GS500
12 I Sample 7.1sa Sample Viiler_snalysishethod_ | filer_v2 CE_GS_Yfiler_GS500
13 h Sample §.1sa Sample Yiler_snalysishethod_ | 'Y filer_v2 CE_G5_Yfiler_GS500
14 s, Sample 9.fsa Sample Viiler_snalysishethod_ | filer_v2 CE_GS_Yfiler_GS500
< |
Progress Status ... I 0%

For more information about any of these tasks, refer to the GeneMapper® ID Software
Version 3.1 Human Identification Analysis User Guide (Pub no. 4338775).

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of
the Project window (assuming the analysis is complete).
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Chapter 4 Analyze Data
For more information

For more information

For details about GeneMapper® ID Software features, allele filters, peak detection
algorithms, and project editing, refer to:

»  GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial
(Pub no. 4335523)

o GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide (Pub
no. 4338775)

e Installation Procedures and New Features for GeneMapper® ID Software Software
Version v3.2 User Bulletin (Pub no. 4352543)
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For more information
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Overview of GeneMapper® ID-X Software

Section 4.2 GeneMapper® ID-X Software

Overview of GeneMapper® ID-X Software

GeneMapper® ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample
in a .fsa file or a .hid file. Using GeneMapper® ID-X Software, you can then analyze
and interpret the data from .fsa files (GeneMapper® ID-X Software v1.0.1 or higher) or
hid files (GeneMapper® ID-X Software v1.2 or higher).

Instruments Refer to “Instrument and software overview” on page 16 for a list of compatible
instruments.
Before you start When using GeneMapper® ID-X Software v1.0.1 or higher to perform human

identification (HID) analysis with AmpF(STR® kits, be aware that:

48

HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a run
folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.
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Set up GeneMapper® ID-X Software for data analysis

Panel, bin, and The file names shown in this section may differ from the file names you see when you

stutter file version  download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper®
ID-X Software.

The instructions and examples in this section refer to the latest version of panel, bin,
and stutter file available at the time of publication.

Before using the Before you use GeneMapper® ID-X Software (v1.0.1 or higher for .fsa files, v1.2 or
software for the higher for .hid files) to analyze data for the first time, you must do the following:

first time 1. Check the version of panel, bin, and stutter files installed with the GeneMapper®
ID-X Software as explained in “Check panel, bin, and stutter file version” below.

®
@
2
(0]
<
QO
©
e}
o)
(©)
S
<
w
o
=3
s
)
(0]

2. Check www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper® ID-X Software to determine if newer files are available.

3. If updated files are available, download and import the files into the
GeneMapper® ID-X Software, as explained in “Import panels, bins, and marker
stutter” on page 50.

Note: When downloading new versions of analysis files, refer to the associated
Read Me file for details of changes between software file versions. If you have
validated previous file versions for data analysis, conduct the appropriate
internal verification studies before using new file versions for operational
analysis.

4. Create an analysis method, as explained in “Create an analysis method” on
page 55.

5. Create a size standard, as explained in “Create size standard” on page 60.

6. Define custom views of analysis tables.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started
Guide (Pub no. 4375574) for more information.

7. Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started
Guide (Pub no. 4375574) for more information.

For more For quick set up instructions, refer to the GeneMapper® ID-X Software Version 1.0 Getting
information Started Guide (Pub no. 4375574).

For details about GeneMapper® ID-X Software features, refer to:
»  GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub no. 4375574)
o GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (Pub no. 4375670)
o GeneMapper® ID-X Software Version 1.0 Reference Guide (Pub no. 4375671)
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Check panel, bin, 1. Start the GeneMapper® ID-X Software, then log in with the appropriate user
and stutter file name and password.
version

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub no. 4375574).

2. Select Tools » Panel Manager.

3. Check the version of files imported into the Panel Manager:

»* Panel Manager

a. Select Panel Manager in the navigation pane. Rl Edt Bins View Help

b. Expand the Panel Manager folder and any sub-
folders to identify the analysis file version already

installed for your kit choice.

O x B 3

E28 .=, Panel Manager

4. Check the version of files available for import into the
Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the Import
Panels dialog box.

b. Navigate to, then open the Panels folder and check the version of panel, bin,
and stutter files installed.

5. If newer versions are available on the website, download and import as described
below.

Import pa nels, To import the Yfiler® Kit panel, bin set, and marker stutter from our web site into the
bins, and marker GeneMapper® ID-X Software database:

stutter 1. Download and open the file containing panels, bins, and marker stutter:

a. Go to www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper® ID-X Software. Download the file AmpFLSTR
Analysis Files GMIDX.

b. Unzip the file.

2. Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub no. 4375574).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

»* Panel Manager
File Edit Bins Wiew Help

Ll >\‘ sl ‘/I '/I

E2R .-, Panel Manager

b. Select File » Import Panels to open the Import
Panels dialog box.

c. Navigate to, then open the AmpFLSTR Analysis
Files GMIDX folder that you unzipped in step 1
on page 50.
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5. Select AmpFLSTR_Panels_v2X (or the version you installed), then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager “AmpFLSTR_Panels_v2X”. This folder contains the panels and
associated markers.

« Import Panels ®
v 2 EE

Look in: E AMpFLSTR. Analysis Files GMIDY

L] AmpFLSTR_Bins_vzx

{ 2) ng'l o
My Recent EI A - .
Documents | ] Reade_AmpFLSTR vz

Desktop

My Documents

-

My Computer

File: name:

(@)
(0]
=}
(0]
<
QO
©°
e}
SE
)]
S
<
wn
o
=3
=
D
(0]

[ Irnpork ]

Cancel

|AmpFLSTR_Panels_v2x.txt |

Files of type: [ All Files |

6. Import AmpFLSTR_Bins_v2X.txt:
a. Select the AmpFLSTR_Panels_v2X folder in the navigation pane.

» Panel Manager.
File Edit Bins Wiew Help

WX (WO W et s e o i GH B E | @EEE

IE

E‘"'d%hpa”d Manager Pamel Harne Comromert.
[C3) AMpFLSTR_MGMSElect_vai 1 Cfiler w1, 1% ndll =)
%AWHSTR—NGM—VSK 7 |SEM_Plos_v1.1% rul
AmpFLSTR_Panels_w1¥
= = MiGI_SElect w2, 1% il
[ AmpFLSTR _Panels_vzx] 5 = -
4 |Idenkifiler _Plus_v1.1% ndll
- RICRA T A ol

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder.

AmpFISTR® Yfiler® PCR Amplification Kit User Guide

51



4 Chapter 4 GeneMapper® ID-X Software
Set up GeneMapper® ID-X Software for data analysis

d. Select AmpFLSTR_Bins_v2X.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AmpFLSTR_Panels_v2X folder.

« Import Bin Set ®
Lok in; E AMpFLSTR. Analysis Files GMIDR v | 5 ,,’:"|| =

i) AmpFLSTR Bins_vex |
L] ArmpFLSTR Panels_vzx
My Recenk QI AmpFLSTR_Stutker_wZx
Locuments | P ReadMe_AmpFLSTR_w2X

8 jie

Desktop

@

My Documents

File name: |&mpFLSTR_Bins_v2X.bxt | [ import |

My Computer | Files of bype: |p||| Files v| Cancel

7. View the imported panels in the navigation pane:
a. Double-click the AmpFLSTR_Panels_v2X folder.

b. Double-click the Yfiler_v1.1X folder to display the panel information in the
right pane.

#* Panel Manager
File Edit Bins ‘Wiew Help

wo> W W B E BinSet: | AmpFLSTR_Bins_w2X v‘ i % o |

iiE

E\---d%bPanel Manager Pane]l Hame Commert.
--@AmpFLSTR_PaneIs_le Ofiler_CODIS_w1,1% ndll
= AmpFLSTR_Pan 1 Wiler_v1.1% mll
%Eﬁg:e:—lc?f SR Identifiler_CODIS_v1.1% |nul
---Eudenti_ﬂler_coom_vl RE
[0y Identifiler_Direck_v1.1%

—

Identifiler_Direct_w1.1%  |null

Identifiler _Plus_v1.1% ndll

L e B = e R )

[y 1dentifiler_Plus_v1.1% Identifiler 1,12 rill
g i:::;tl:glri—:ll; 4 MiniFiler_v1.1% nul
B-[CINGM_SElect_vz. 1% WGEM_SElect_v2, 1K nll
- MEM _va. 1% NGM_v3. LK rull
& [DProfiler_Plus_CODIS_v1.1% 10 |Profiler_Flos_CODIS_vl, 1|l
g E:E::::zl: lsl_xvl s 11 |Profiler_Plus_v1.1¥ null
B SEfiler_Plus_v1.1% 12 |Profiler_wl.1x ndll
N T U g pu—— g B "
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8. Select and expand Yfiler_v1.1X in the navigation pane, then select B_DYS3891I to
display the Bin view for the marker in the right pane.

#* Panel Manager,

File Edit Bins Wiew Help
o X | G H W | JE W | ense: |.0.mpFLSTR_Bins_v2>< v| WLESE BEEEEEERE o
=) g Panel Manager ~
--[E]AmpFLSTR_PaneIs_VIX 10 24 245 26 27 28 29 30 21 32 i el G)
= AmpFLSTR_Panels_yzx e
- COfiler_CODIS_vi.1% 0.9 %
= ¥filer vl 18 pis >
v ¥_OY5391 ' g
¥_DYS5439 07 @
-¥_DYS635 )
Y _DY5392 I 0.6 S
U
R_Y¥_GATA_H4 i >~
-R_DV¥5437 1%
-R_DV¥5438 04 ,%
-R_DV5448 =
- B_D5456 b3 %
-B_DY¥53891 s
0.1
2 b
R ucare 2
< | > 00
A 241243 245 247 249 251 253 255 257 259 261 263 265 26T 269 271 273 275 2TV 279 2841 283 285 28T 289 291293 295 297 239 301303 305 307
------ ,g,, Reference Samples
B_DS3aall
< L
[ (o4 ] [ Cancel ] [ apply ] ’ Help ]

9. Import AmpFLSTR_Stutter_v2X:
a. Select the AmpFLSTR_Panels_v2X folder in the navigation panel.

« Panel Manager
File Edit Bins Yiew Help

w X W E ™ snset:|amprsTrEns_ . vl By OB BB

IE

= 4, Panel Manager Paniel Hame Coatnert
[CAmpFLSTR_MGMSEleck w2y 1 Ofiler w1, 1% null =
EF‘WPF'—STR_NGM_VW Z |5GM Plus_vi.1% nul
AmpFLSTR_Panels_v1x
= = MWEM_SElect_w2. 1% null
8 AmpFLSTR_Panel 3 et
4 |Identifiler_Plus_wi.1% null

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog
box.

c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder.
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d. Select AmpFLSTR_Stutter_v2X, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the AmpFLSTR_v2X folder.

« Import Marker, Stutter ®
Look in: E AmpFLSTR. Analysis Filss GMIDH v | 5 ,:J|| =

L AmpFLSTR_Bins _ves
L AmpFLSTR_Panels_va

&

My Recent B AmpFLSTR_Stutte
Locuments | ] ReadMe_AmpFLSTR_w2X

]
iy
.

-
IS
h=]

My Documents

%! File name: |AmpFLSTR_Stutter_v2:.txt | [ mport |

My Compuker | Files of bype: |.0.II Files v| Cancel

10. View the imported marker stutters in the navigation pane:

a. Double-click the AmpFLSTR_Panels_v2X folder to display its list of kits in
the right pane.

b. Double-click the Yfiler_v1.1X folder to display its list of markers below it.

c. Double-click Y_DYS392 to display the Stutter Ratio & Distance view for the
marker in the right pane.

#* Panel Manager

File Edit Bins ‘Wiew Help

o % @' B OB [ ™ Binset: |AmpFLSTR_Bins_v2x v‘ W] E BEEBEESRI
= gfpPanel Manager ”~ :
,@AmpFLSTR_pane|s_m — || Please enter the stutter filter(s) for ¥_DYS392 marker here If left blank, the global stutt
= CHAmpFLSTR Parels_v2y applied.
- COfller_CODIS 11X
- filer_w1.1% ;
B v_DYS3a1 Minus Stutter Plus Stutter
- ¥_DY5439 Ratio
- ¥_DY¥S635
- ¥_DY5392
O Stutter Ruatin i
~R_Y_GATA_H4
- R_DYs437
- R_DYs5438
- R_DY5448 [ mew |[ Edt |[ Delete |

From Diskance To Distance Ratio From Distance
AE22 2,25 375 L0730 2,25

E R T R SR
BN TR SR

11. Click Apply, then OK to add the Yfiler® Kit panel, bin set, and marker stutter to
the GeneMapper® ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels,
bin sets, and marker stutter will not be imported into the GeneMapper® ID-X
Software database.
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Create an analysis  Use the following procedure to create an analysis method for the Yfiler® Kit.
method

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created for
GeneMapper® ID-X version 1.2 is not compatible with earlier versions of
GeneMapper® ID-X Software or with GeneMapper® ID Software version 3.2.1.

1. Select Tools » GeneMapper® ID-X Manager to open the
GeneMapper® ID-X Manager.

 GeneMapper® ID-X Manager (%]

Find Mame Conkaining:

(@)
(0]
=}
(0]
<
Q
©
e)
o)
)
S
<
w
o
=3
s
L
(0]

Projects | Analysis Methods | Table Settings || Plaot Settings || Matrices | Size Standards | Report Settings

[ Mew... ][ Open... ][ Save As... ][ Import... ][ Export,..

2. Select the Analysis Methods tab, then click New to open the Analysis Method
Editor with the General tab selected.

3. The figures below show the settings for each tab of the Analysis Method Editor.
Configure the Analysis Method Editor tab settings as shown in the figures below,
unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

4. After you enter settings in all tabs, click Save.
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General tab
settings Analysis Method Editor

x)

@eneral | Allele | Peak Detector || Peak Quality | 59 & G0 Settings |

—analysis Method Description
Mame: |‘r’FiIer_nnal',-'sisMbthod_vzx |
Security Graup: |GeneMa|:||:|er ID-% Security Group L |
Descripkion: ~
a3
Instrument:
Analysis Type: HID

[ Save ][ Cancel ” Help ]

In the Name field, either type the name as shown or enter a name of your choosing. In
the Security Group field, select the Security Group appropriate to your software

configuration from the dropdown list. The Description and Instrument fields are
optional.
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Allele tab settings

]

Analysis Method Editor

| General | Allele: | Peak Detector || Peak, Quality || SleR Y elal Settings|

Bin Set: AronLSTF!._E:in
Use marker-specific stutter ratio and distance if available

Marker Repeat Type: Tri Tetra Penta Hexa

Global Cut-off Yalue 0.0 0.0 0.0 0.0

Minus4 Ratio 0.0 0.0 0.0 0.0

Minusa Distance From (0.0 0.0 0.0 0.0
To (0.0 0.0 0.0 0.0

Global Minus Skutker Ratio 0.0 0.0 0.0 0.0

Global Minus Skutker Distance  From (0.0 3.25 0.0 0.0
To (0.0 4,75 0.0 0.0

Global Plus Stutter Ratio 0.0 0.0 0.0 0.0

Global Plus Skukter Distance Fram |0.0 0.0 0.0 0.0
To (0.0 0.0 0.0 0.0

Amelogenin Cukoff

F.ange Filter. .. Fackory Defaults

[ Save ][ Zancel ][ Help ]

* In the Bin Set field, select the AmpFLSTR_Bins_v2X bin set.

* GeneMapper® ID-X Software v1.0.1 or higher allows you to specify 4 types of
marker repeat motifs: tri, tetra, penta and hexa. You can enter parameter values
for each type of repeat in the appropriate column.

¢ Specify the stutter ratio:

— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for
single-source sample data.

— To apply the stutter ratios contained in the AmpFLSTR_Panels_v2X file,
select the “Use marker-specific stutter ratio if available” check box (selected
by default). Perform appropriate internal validation studies to determine the
appropriate filter setting to use.
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Peak Detector tab
settings

58

Analysis Method Editor, &

General | Allele |; " {| Peak Quality | 5Q & GO Settings
Peak Detection Algorithm: Advanced
Ranges Peak Detection Perf
errorm
Analysis Sizirg Peak. Amplitude Thresholds: internal
Full R. v Al 5i v o a
Sl = R validation
o studies to
) determine
settings
~amoothing and Baselining
Min. Peak Half Width: 2 pts
Sroathing ) Mone
i 2 3
) Light Polynomial Degree
() Heawy Peak Window Size: 15 pts
Baseline Wwindow: 51 pts Slope Threshold
Peak Start: 0.0
r3ize Calling Method Peak End: 0.0
(") 2nd Order Least Squares
() 3rd Order Least Squares
(") Cubic Spline Interpalation
() Lacal Southern Methad
(") Global Southern Method
Factory Defadls
[ Save As ] [ Save ] [ Cancel ] [ Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
appropriate peak amplitude thresholds for interpretation of Yfiler® Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the

minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper® ID-X Software displays peaks that fall below the specified
amplitude in electropherograms, the software does not label or determine the
genotype of these peaks.

Size calling method - The Yfiler® Kit has been validated using the Local
Southern sizing method. Select alternative sizing methods only after performing
the appropriate internal validation studies.

Normalization — A Normalization checkbox is available on this tab in
GeneMapper® ID-X Software v1.2 for use in conjunction with data run on the
Applied Biosystems® 3500 Series Genetic Analyzers. Users of this version of
software should perform laboratory evaluations to determine whether to use the
Normalization feature for analysis of Yfiler® Kit data.
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Peak Quality tab

) Analysis Methed Editor &
settings p—

|| 50 & GQ Settings

mIMax Peak Height (LPH{MPH] \

Homozygous min peak height I:I Perform
Heterozygous min peak height I:I internal
Max Peak Height (MPH) [ ] \s/’?lrgiaegotrc]) g
determine %
settings [
Peak. Height Ratio (PHR) g
@ peak height: ratio I:l j 9;@
S
>
Broad Peak (BDY g)
Max peak width (basepairs) g’
o
1)

Allele Mumber (AR

I

Max expected alleles

Allelic Ladder Spike
Cut-off Yalue 0.z

[ Factory Defaults

[ Save H Cancel H Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds,
maximum peak height threshold and the minimum peak height ratio threshold for
interpretation of Yfiler® Kit data.
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SQ & GQ tab Analysis Method Ed (x]
. nalysis Metho itor
settings = —
General | &llele | Peak Detector | Peak Quality | 50 & GO Settings |
Cuality weights are between 0 and 1,
rSample and Control GO Weighting
Broad Peak (BL) 0.5 Allele Mumber (AR 1.0
Qut af Bin Allele (BIN) 0.5 Low Peak Height (LPH) 0.3
Overlap (VL) 0.5 Max Peak Height (MPH) 0.3
Marker Spike [SPK) 0.3 Off-scale (05) 0.5
Peak. Height Ratio (PHR) 0.3
Contral Concordance (ZC) Weight = 1.0 (Only applicable ko contrals)
30 weighting
Broad Peak (BD)
rallelic Ladder G0 weighting
Spike (SSPKJSPE) Off-scale (03)
S0 & G0 Ranges
| PassRange: | [NEEIGUSIEARERGEI
Sizing Ciuality: From | 0.75 to 1.0 FromO.0ko | 025
Genobype Guality:  From | 0.73 to 1.0 FromO.0ko
[ Save As ] [ Save ] [ Zancel ] [ Help ]
IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform appropriate internal validation studies to
determine the appropriate values to use.
Create size The size standards for the Yfiler® Kit use the following size standard peaks in their
stan d a rd definitions:
GeneScan™ 500 LIZ® Size Standard peak | GeneScan™ 600 LIZ® Size Standard v2.0
sizes peak sizes

75,100, 139, 150, 160, 200, 300, 340, 350, 400, | 80, 100, 114, 120, 140, 160, 180, 200, 214, 220,
and 450 240, 250, 260, 280, 300, 314, 320, 340, 360,
380, 400, 414, 420, 440 and 460

Note: The 250-nt peak in the GeneScan'" 500 LIZ® Size Standard is not included in the
size standard definition. This peak can be used as an indicator of precision within a
run.

Use the following procedure to create the appropriate size standard:

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
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2. Select the Size Standards tab, click New, select the Basic or Advanced radio
button, then click OK.

»* GeneMapper® ID-X Manager

Find Mame Containing: |

Projects | Analysis Methods | Table Settings | Plot Settings || Matrices | Size Standards | Report Settings|

(@)

(¢

=)

[©)

<

MName Last Saved Cwner Type Descripkion %
CE_F_HID 5500 (75-400) 2007-08-09 13:23:5 [gmidx advanced ~ '8
CE_F_HID 55500 (75-450) 2007-08-09 13:24:C | grmidx advanced B
—

&)

U

G3600_LIZ 2012-07-05 22:15:¢ | gmidx Advanced >0§
GS600_LIZ+Mormalization_{30-400) 2007-06-27 01:43:1 | gridx Advanced B %
GSE00_LIZ_(80-400) 2007-06-27 01:43:1|gmidx Advanced @ 5
=

(0}

[ New... ][ Open... ” Save As... ” Import... ][ Expart...
(b ) (Coene |

3. Enter a name (for example, CE_G5_Yfiler_GS500 as shown below). In the Size
Standard Dye field, select Orange. In the Size Standard Table, enter the sizes
specified in on page 60. The example below is for the GeneScan"" 500 LIZ® Size
Standard.

»* Size Standard Editor
Edit

rSize Standard Description
Mame: CE_G5_filer_GS500

Security Group:

Description:

Size Standard Dye: QOrange w |

rSize Standard Table

_| Si;:auin Basepairs

2 1000

—

3 |139.0

4 |150.0

5 |la0.0

& (2000

7 (3000

g |340.0

9 |350.0

10 (4000

11 (450.0

[ QK ” Cancel H Help ]
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Analyze and edit sample files with GeneMapper® ID-X Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings

Sample Type Select the sample type.

Analysis Method  Yfiler_AnalysisMethod_v2X (or the name of the analysis method
you created)

Panel Yfiler_v1.1X
Size Standard CE_Gb5_Yfiler_GS500 (or the name of the size standard you created)

For more information about how the Size Caller works, or about size standards,
refer to the GeneMapper® ID-X Software v1.2 Reference Guide (Pub no. 4426481A).
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Examine and edit a project

3. Click ™ (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

* The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage indicated.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

¢ The Analysis Summary tab is displayed and the Genotypes tab becomes
available upon completion of the analysis.

Analysis summary window after analysis

#* GeneMapper® ID-X - Yfiler Example - gmidx Is Logged In Database GBOLDROYNJOSE

(@)
(0]
=}
(0]
<
Q
©°
e}
SE
)]
S
<
wn
o
=3
=
2
(0]

File Edit Analysis Wiew Tools Admin  Help
o ﬁ % g E| Ul Eﬁ [ 3 @ Table Setting:  |31%¥ Data Analysis W | ,O =K B a
B---&bproject : Samples| Analysis Summary | Genotypes
-1y ¥filer Example =
Analysis Summary =
Select run Folder to display:
( Sarmple Status [ Total # of Samples |
[ﬁ Unanalyzed 0
Analyzed 14
[ analysis Setting Changed 0
Click a link below to display a filtered Samples Tahle containing only the samples selected.
Allelic Ladder Quality per run folder {based on SQ and CGQ only)
Run Folder [ Total # of Analyzed Ladders ] [ & [ r]
‘iler Example 3 | 3 0 1] |
Control Quality per project (based on sample POVs: S80S, SSPK, MIX, OMR, 5Q, CGQ)
Control Type Total # of Samples ] All thresholds met [ O One of more thresholds not o
Positive Contral i} a a
Custom Control ] 0 0
Megative Control i} i} i}
Takal a a a
Sample Quality per project {based on sample POVs: S0S, S5PK, MIX, OMR, SQ, CGQ)
[ ][ Total # of Samples ] Al thresholds met ][ 0 One or more thresholds not i
Samples | 11 | 0 | 11 v
< | ¥
Analysis Completed, | Stop

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).
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For more information

For more information, refer to:
»  GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub no. 4375574)
o GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (Pub no. 4375670)
o GeneMapper® ID-X Software Version 1.0 Reference Guide (Pub no. 4375671)

o GeneMapper® ID-X Software Version 1.1(Mixture Analysis) Getting Started Guide
(Pub no. 4396773)

o GeneMapper® ID-X Software Version 1.2 Reference Guide (Pub no. 4426481)
o GeneMapper® ID-X Software Version 1.2 Quick Reference Guide (Pub no. 4426482)

»  GeneScan® Analysis Software for the Windows NT® Operating System Overview of the
Analysis Parameters and Size Caller User Bulletin (Pub no. 4335617).
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Chapter 5 Experiments and Results

Overview

Section 5.1 Developmental Validation

Overview

Importance of
validation

Experiment
conditions

66

This chapter provides results of the developmental validation experiments we
performed using the AmpF(STR® Yfiler® PCR Amplification Kit.

Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics. By
challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations
which are critical for sound data interpretation in casework (Sparkes, Kimpton,
Watson et al., 1996; Sparkes, Kimpton, Gilbard et al., 1996; Wallin ef al., 1998).

We performed experiments to evaluate the performance of the Yfiler® Kit according to
the DNA Advisory Board (DAB) Quality Assurance Standards, effective October 1,
1998 (DNA Advisory Board, 1998). The DAB standards describe the quality assurance
requirements that a laboratory should follow to ensure the quality and integrity of the
data and competency of the laboratory.

We performed additional studies according to the revised guidelines from the
Scientific Working Group on DNA Analysis Methods (SWGDAM, July 10, 2003). This
DNA methodology is not novel (Moretti et al., 2001; Frank et al., 2001; Wallin et al.,
2002; and Holt et al., 2001).

Based on these standards, we conducted experiments which comply with Standards
1.0 and 2.0 and its associated subsections. Whereas this DNA methodology is not
novel, Standard 8.1.2 and its related subsections have been addressed (Holt et al., 2001
and Wallin ef al., 2001). This chapter will discuss many of the experiments we
performed and examples of the results we obtained. We used conditions that produced
maximum PCR product yield and a window in which reproducible performance
characteristics were met. These experiments, while not exhaustive, are appropriate for
a manufacturer, in our opinion. Each laboratory using the Yfiler® Kit should perform
appropriate validation studies.
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Developmental validation

Developmental validation

SWGDAM Guideline “Developmental validation is the demonstration of the accuracy, precision, and reproducibility
1.2.1 of a procedure by the manufacturer, technical organization, academic institution, government
laboratory, or other party.” (SWGDAM, July 2003).

Critical reagent concentrations and reaction conditions (such as thermal cycling
parameters, AmpliTaq Gold® DNA polymerase activation, cycle number) to produce
reliable, locus-specific amplification and appropriate sensitivity have been
determined.

SWGDAM Guideline  “The reaction conditions needed to provide the required degree of specificity and robustness
2.1.0.1 must be determined. These include thermocycling parameters, the concentration of primers,
magnesium chloride, DNA polymerase, and other critical reagents.” (SWGDAM, July 2003).

@)
1)
<
o
o
ke
3
o
>
—
D
&
5
=
o
=)

PCR components The concentration of each component of the Yfiler® Kit was examined. The PCR
components are Tris-HCl (pH 8.3), KCl, dNTPs, primers, AmpliTaq Gold® DNA
Polymerase, MgCl,, bovine serum albumin, and sodium azide. The concentration for a
particular component was established to be in the window that meets the reproducible
performance characteristics of specificity and sensitivity (Figure 4). The performance
of the multiplex is most robust within a + 20% window of magnesium chloride.

Figure 4 A 1 ng amplification of male genomic DNA varying the MgCl, concentration, analyzed
on the 3100 Genetic Analyzer
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Thermal cycler Thermal cycling parameters were established for amplification of the Yfiler® Kit in the

parameters GeneAmp® PCR Systems 9600 and 9700. Thermal cycling times and temperatures of
GeneAmp PCR systems were verified. Annealing and denaturation temperature
windows were tested around each stipend to verify that a +1.0°C window produced a
specific PCR product with the desired sensitivity of at least 1 ng of AmpF(STR®
Control DNA 007.
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PCR cycle number

68

The effects of denaturation and annealing temperatures on the amplification of Yfiler®
Kit loci were examined using AmpF(STR® Control DNA 007 and two DNA samples.

The denaturation temperatures tested were 92.5, 94, and 95.5°C, all for 1-minute hold
times on the GeneAmp PCR System 9700. The annealing temperatures tested were 59,
60, 61, 62, and 63°C (Figure 5), also for 1-minute hold times in the GeneAmp PCR
System 9700 with the silver 96-well block. The PCR products were analyzed using the
3100 Genetic Analyzer.

No preferential amplification was observed in the denaturation temperature
experiments. Of the tested annealing temperatures, 59, 60, and 61°C produced robust
profiles. At 63°C, the yield of the majority of loci was significantly reduced. This
should pose no problem with routine thermal cycler calibration and when following
the recommended amplification protocol. Preferential amplification was not observed
at standard annealing temperature of 61°C.

Figure 5 An amplification of 1 ng of genomic DNA, amplified while varying the annealing

temperature, analyzed on the 3100 Genetic Analyzer
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The Yfiler® Kit reactions were amplified for 28, 29, 30, 31, and 32 cycles on the
GeneAmp® PCR System 9700 using 1.0 ng of three DNA samples. As expected, PCR
product increased with the number of cycles (Figure 6). A full profile was generated at
28 cycles; off-scale data were collected for several allele peaks at 32 cycles.

While none of the cycle numbers tested produced nonspecific peaks, 30 cycles was
found to give optimal sensitivity when the amplified products were examined on 3100
Genetic Analyzers. At 30 cycles, high ratios of female to male DNA amplify reliably
and specifically following the conditions outlined in this user manual (Figure 18 on

page 87).
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Figure 6 An amplification of 1 ng of genomic DNA, amplified while varying the cycle number,
analyzed on the 3100 Genetic Analyzer
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Accuracy, precision, and reproducibility

SWGDAM Guideline
2.9

“The extent to which a given set of measurements of the same sample agree with their mean and
the extent to which these measurements match the actual values being measured should be
determined.” (SWGDAM, July 2003).

Laser-induced fluorescence detection systems of length polymorphism at short
tandem repeat loci is not a novel methodology (Holt et al., 2001 and Wallin et al., 2001).
However, accuracy and reproducibility of Yfiler® Kit profiles have been determined
from various sample types.

Figure 7 illustrates the size differences that are typically observed between sample
alleles and allelic ladder alleles on the 3100 Genetic Analyzer with POP-4® polymer.
The x-axis in Figure 7 represents the nominal base pair sizes for the AmpF(STR®
Yfiler® Allelic Ladder, and the dashed lines parallel to the x-axis represent the +0.5-bp
windows. The y-axis is the deviation of each sample allele size from the corresponding
allelic ladder allele size. All sample alleles are within 0.5 bp of a corresponding allele in
an allelic ladder.
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Precision and size
windows

70

Figure 7 Size deviation of 78 samples analyzed on the 3100 Genetic Analyzer
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Sizing precision allows for determination of accurate and reliable genotypes. Sizing
precision was measured on the 3100 Genetic Analyzer. The recommended method for
genotyping is to use a +0.5-bp “window” around the size obtained for each allele in the
AmpF(STR® Yfiler® Allelic Ladder. A +0.5-bp window allows for the detection and
correct assignment of alleles. Any sample allele that sizes outside a window could be
either of the following;:

¢ An “off-ladder” allele, for example, an allele of a size that is not represented in the
AmpF(STR® Yfiler® Allelic Ladder

* An allele that does correspond to an allelic ladder allele, but whose size is just
outside a window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree of
precision in sizing an allele multiple times. Precision is measured by calculating the
standard deviation in the size values obtained for an allele that is run in several
injections in one capillary run. Table 3 on page 71 indicates typical precision results
obtained from the seven injections of the AmpF(STR® Yfiler® Allelic Ladder analyzed
on the 3100 Genetic Analyzer (47-cm capillary and POP-4® polymer). The size
standard used was GeneScan"" 500 LIZ® Size Standard. These results were obtained
within a set of injections on a single capillary.

As indicated above, sample alleles may occasionally size outside of the +0.5-bp
window for a respective allelic ladder allele because of measurement error. The
frequency of such an occurrence is lowest in detection systems having the smallest
standard deviations in sizing. Figure 7 illustrates the tight clustering of allele sizes
obtained on the 3100 Genetic Analyzer, where the standard deviation in sizing is
typically less than 0.15 bp. The instance of a sample allele sizing outside of the +0.5-bp
window because of measurement error is relatively rare when the standard deviation
in sizing is approximately 0.15 bp or less (Smith, 1995).
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For sample alleles that do not size within a +0.5-bp window, the PCR product must be
rerun to distinguish between a true off-ladder allele vs. measurement error of a sample
allele that corresponds with an allele in the allelic ladder. Repeat analysis, when
necessary, provides an added level of confidence to the final allele assignment.
GeneMapper® ID Software and GeneMapper® ID-X Software automatically flags
sample alleles that do not size within the prescribed window around an allelic ladder
allele.

It is important to note that while the precision within a set of capillary injections is very
good, the determined allele sizes vary between platforms. Cross-platform sizing
differences arise from a number of parameters, including type and concentration of
polymer mixture, run temperature, and electrophoresis conditions. Variations in sizing
can also be found between runs on the same instrument and between runs on different
instruments because of these parameters. We strongly recommend that the allele sizes
obtained be compared to the sizes obtained for known alleles in the AmpF(STR®
Yfiler® Allelic Ladder from the same run and then converted to genotypes. For more
information on precision and genotyping, see Lazaruk ef al., 1998 and Mansfield

et al.,1998.
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Table 3 Example of precision results of nine injections of the AmpF(STR® Yfiler® Allelic Ladder
run on the 3100 Genetic Analyzer

Allele Mean Standard Deviation
DYS456
13 104.51 0.05
14 108.31 0.05
15 112.16 0.04
16 116.04 0.04
17 119.90 0.05
18 123.82 0.05
DYS389I
10 142.87 0.04
1" 147.28 0.04
12 151.80 0.06
13 156.43 0.07
14 160.66 0.05
15 164.81 0.07
DYS390
18 192.26 0.05
19 195.99 0.04
20 199.93 0.05
21 203.85 0.06
22 207.83 0.05
23 211.90 0.04
24 215.90 0.05
25 219.88 0.06
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Accuracy, precision, and reproducibility

Allele Mean Standard Deviation
26 223.84 0.06
27 227.80 0.07
DYS389Il
24 253.05 0.05
25 257.17 0.06
26 261.19 0.07
27 265.38 0.08
28 269.42 0.08
29 273.36 0.06
30 277.63 0.07
31 281.76 0.09
32 285.78 0.07
33 289.93 0.05
34 293.94 0.06
DYS458
14 130.98 0.05
15 134.87 0.06
16 138.81 0.03
17 142.95 0.05
18 147.31 0.05
19 151.72 0.05
20 155.94 0.04
DYS19
10 176.06 0.07
" 179.98 0.05
12 183.84 0.05
13 187.76 0.03
14 191.64 0.05
15 195.49 0.05
16 199.32 0.05
17 203.20 0.06
18 207.09 0.07
19 211.02 0.06
DYS385 a/b
7 242.79 0.05
8 246.89 0.07
9 250.94 0.04
10 254.98 0.07
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Accuracy, precision, and reproducibility

Allele Mean Standard Deviation
1" 259.04 0.08
12 263.08 0.06
13 267.24 0.05
14 271.38 0.06
15 275.47 0.10
16 279.56 0.08
17 283.70 0.07
18 287.79 0.05
19 292.06 0.06
20 296.19 0.07
21 300.42 0.06
22 305.06 0.12
23 309.50 0.07
24 313.99 0.10
25 318.39 0.05
DYS393
8 100.26 0.05
9 104.19 0.04
10 108.05 0.04
" 112.04 0.04
12 115.98 0.04
13 119.89 0.04
14 123.89 0.04
15 127.80 0.05
16 131.95 0.04
DYS391
7 150.88 0.08
8 155.27 0.06
9 159.67 0.06
10 163.83 0.05
" 167.94 0.07
12 172.00 0.07
13 176.03 0.06
DYS439
8 197.84 0.05
9 201.70 0.03
10 205.68 0.05
" 209.46 0.04
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5 Chapter 5 Experiments and Results
Accuracy, precision, and reproducibility

Allele Mean Standard Deviation
12 213.47 0.03
13 217.41 0.03
14 221.42 0.05
15 225.17 0.04
DYS635 (Y GATA C4)
20 246.43 0.07
21 250.49 0.06
22 254.45 0.06
23 258.49 0.03
24 262.45 0.06
25 266.56 0.06
26 270.56 0.03
DYS392
7 291.38 0.05
8 294.39 0.07
9 297.44 0.06
10 300.30 0.06
1" 303.91 0.07
12 307.44 0.07
13 310.64 0.08
14 313.74 0.07
15 317.12 0.1
16 320.45 0.08
17 323.54 0.09
18 326.79 0.10
Y GATA H4
8 122.01 0.06
9 125.98 0.06
10 129.97 0.07
" 134.01 0.04
12 138.09 0.03
13 142.37 0.05
DYS437
13 182.53 0.05
14 186.45 0.07
15 190.40 0.04
16 194.25 0.04
17 198.07 0.03
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Accuracy, precision, and reproducibility

Allele Mean Standard Deviation

DY438
8 223.69 0.06
9 228.68 0.06
10 233.63 0.07
1" 238.59 0.06
12 243.63 0.05
13 248.66 0.05

DYS448
17 280.49 0.04
18 286.58 0.03
19 292.70 0.05
20 298.92 0.05
21 305.51 0.04
22 312.25 0.06
23 318.60 0.10
24 324.88 0.08
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Chapter 5 Experiments and Results

Extra Peaks in the electropherogram

Extra Peaks in the electropherogram

Causes of extra
peaks

Stutter products

76

Peaks other than the target alleles may be detected on the electropherogram displays.
Several causes for the appearance of extra peaks, including the stutter product (at the
n—4 position), incomplete 3" A nucleotide addition (at the n—1 position), artifacts, and
mixed DNA samples (see “SWGDAM Guideline 2.8” on page 86).

A stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller (or less frequently, one repeat larger) than the major STR
product (Butler, 2001). Sequence analysis of stutter products at tetranucleotide STR
loci has revealed that the stutter product is missing a single tetranucleotide core repeat
unit relative to the main allele (Walsh et al., 1996). It has been reported that the DYS19
tetranucleotide repeat locus displays the typical -4 bp stutter but also a -2 bp stutter
(Prinz, et al., 2001; Gusmao, et al., 1999). The DYS392 trinucleotide repeat locus displays
the typical -3 bp stutter but also a smaller +3 bp stutter. Sequence analysis of this +3 bp
stutter revealed that the product contains an additional repeat unit relative to the true
allele peak.

The proportion of the stutter product relative to the main allele (stutter percent) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. Such measurements have been made for amplified samples at the loci used in the
Yfiler® Kit. All data were generated on the 3100 Genetic Analyzer.

Some of the general conclusions from these measurements and observations are as
follows:

* For each Yfiler® Kit locus, the stutter percent generally increases with allele
length, as shown in Figure 8 through Figure 11 on the following pages. Smaller
alleles display a lower level of stutter relative to the longer alleles within each
locus. This is reflected in Figure 8 through Figure 11, where minimal data points
are plotted for some smaller alleles, as stutter could not be detected for many of
these samples.

* Each allele within a locus displays percent stutter that is reproducible.

* The highest observed stutter percent for each locus is included as the filter in the
GeneMapper® ID Software and the GeneMapper® ID-X Software. Peaks in the
stutter position that are above the highest observed stutter percent will not be
filtered. Peaks in the stutter position that have not been filtered and remain
labeled can be further evaluated. For evaluation of mixed samples, see “Mixture
studies” on page 86.

* The measurement of percent stutter may be unusually high for main peaks that
are off-scale.
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Extra Peaks in the electropherogram

Figure 8 Stutter percentages for the DYS456, DYS3891, DYS390 and DYS389II
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Figure 9 Stutter percentages for the DYS458, DYS19 and DYS385 loci. The -4 bp and -2 bp
stutter percentages for DYS19 are shown in blue and green, respectively
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Extra Peaks in the electropherogram

Figure 10 Stutter percentages for the DYS393, DYS391, DYS439, DYS635, DYS392 loci. The
DYS392 (-3 bp) and (+3 bp) stutter percentages are shown in blue and grey respectively.
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Figure 11 Stutter percentages for the Y GATA H4, DYS437, DYS438 and DYS448 loci
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Addition of 3'A AmpliTaq Gold® enzyme, like many other DNA polymerases, can catalyze the

addition of a single nucleotide (predominately adenosine) to the 3" ends of
double-stranded PCR products (Clark, 1988; Magnuson et al.,1996). This non-template
addition results in a PCR product that is one base pair longer than the actual target
sequence, and the PCR product with the extra nucleotide is referred to as the “+A”
form (Figure 12).

78 AmpFISTR® Yfiler® PCR Amplification Kit User Guide



Section 5.1 Developmental Validation

Extra Peaks in the electropherogram

’

The efficiency of “A addition” is related to the particular sequence of the DNA at the 3
end of the PCR product. The Yfiler® Kit includes two main design features that
promote maximum A addition:

® The primer sequences have been optimized to encourage A addition.

¢ The final extension step is 60°C for 80 minutes.

This final extension step gives the AmpliTaq Gold® DNA Polymerase extra time to
complete A addition to all double-stranded PCR product. STR systems that have not
been optimized for maximum A addition may have “split peaks”, where each allele is
represented by two peaks one base pair apart.

Figure 12 Split peaks resulting from incomplete A nucleotide addition due to omission of the
80-minute extension step
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Lack of full A nucleotide addition may be observed in Yfiler® Kit results when the
amount of input DNA is greater than recommended protocols. This is because more
time is needed for AmpliTaq Gold® DNA Polymerase to add the A nucleotide to all
molecules as more PCR product is generated. Amplification of too much input DNA
will also result in off-scale data.

Artifacts Artifacts, or anomalies, have been seen in data produced on genetic analyzers when
using the Yfiler® Kit. In amplified samples, artifacts in the non-calling region may
appear in the green (88 bp), black (80 and 95 bp), and red (80 bp) dye. Low level
artifacts in the calling region may or may not be reproducible.

Figure 13 demonstrates reproducible artifacts while using the Yfiler® Kit. Consider
these artifacts when interpreting data.
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Figure 13 Examples of baseline noise and reproducible artifacts in data produced on the 3100
Genetic Analyzer (Peak Amplitude Threshold set to 25 RFU to illustrate artifacts)
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Genotyping may result in the detection of these artifacts as off-ladder alleles, or “OL
Alleles”.

Note: A high degree of magnification (y-axis) is used in this figure to illustrate these
artifacts (data produced on capillary electrophoresis instrument platforms).

Characterization of loci

SWGDAM Guideline

2.1

Nature of the
polymorphisms

80

“The basic characteristics of a genetic marker must be determined and documented.”
(SWGDAM, July 2003).

This section describes basic characteristics of the 17 loci that are amplified with the
Yfiler® Kit. These loci have been extensively characterized by other laboratories
(Gusmao et al., 1999; Butler et al., 2002; Gonzalez-Neira et al., 2001; Hall and Ballantyne,
2003; Redd et al., 2002; Schoske et al., 2004).

DYS392 is a trinucleotide repeat, DYS438 is a pentanucleotide repeat and DYS448 is a
hexanucleotide repeat. Their allele differences result from differences in the number of
repeat units 3-bp, 5-bp and 6-bp respectively. The remaining Yfiler® Kit loci are
tetranucleotide short tandem repeat (STR) loci. The length differences among alleles of
these particular loci result from differences in the number of 4-bp repeat units.

We have sequenced all the alleles in the AmpF/STR® Yfiler® Allelic Ladder. In
addition, other groups in the scientific community have sequenced alleles at some of
these loci (Redd et al., 2002; www.cstl.nist.gov/biotech/strbase/y_strs.htm ). Among
the various sources of sequence data on the Yfiler® Kit loci, there is consensus on the
repeat patterns and structure of the STRs.
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Species specificity

Inheritance The Centre d’Etude du Polymorphisme Humain (CEPH) has collected DNA from
39 families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to characterize
the mode of inheritance of various DNA loci. Each family set contains three
generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance
patterns (Begovich et al.,1992).

Three CEPH family DNA sets were examined. 1 ng of DNA from each sample was
amplified using the Yfiler® Kit and the Identifiler® Kit, followed by analysis using a
3100 Genetic analyzer. The families examined included #1333 (9 offspring, 7 males),
#1340 (7 offspring, 5 males), and #1345 (7 offspring, 5 males), representing 23 meiotic
divisions. The Identifiler® Kit results confirmed that the loci are inherited according to
Mendelian rules, as reported in the literature (Nakahori ef al.,1991; Edwards et al.,1992;
Kimpton et al.,1992; Mills et al.,1992; Sharma and Litt, 1992; Li et al.,1993; Straub et
al.,1993). The Yfiler® Kit results confirmed that the loci were inherited according to a
Y-linked (father to son) transmission. In no case was the maternal grandfather’s Y-
haplotype found in the offspring. In family #1345, one son (1345-7356) had a DYS458-
18 allele while the rest of his male relatives had a DYS458-17 allele. In family #1340 one
son (1340-7342) had a DYS458-16 allele while the rest of his male relatives had DYS458-
17. Calculation of a mutation rate based on this small population size would be
inaccurate due to the small sample size. The samples were reamplified and reinjected
to confirm the allele call.
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Ma pping The Yfiler® Kit loci have been mapped and the chromosomal location on the
Y-chromosome is known based on the nucleotide sequence of the Y-chromosome. The
Genbank accession numbers for representative sequences are: DYS19 (X77751,
AC017019), DYS385 (AC022486, Z93950), DYS389 (AC011289, AF140635), DYS390
(AC011289), DYS391 (G09613, AC011302), DYS392 (G09867, AC06152), DYS393
(G09601, AC06152), DYS437 (AC002992), DYS438 (AC002531), DYS439 (AC002992),
DYS448 (AC025227.6), DYS456 (AC010106.2), DYS458 (AC010902.4), DYS635 (G42676,
AC011751) and Y GATA C4 (G42673).

Species specificity

SWGDAM Guideline “For techniques designed to type human DNA, the potential to detect DNA from forensically
2.2 relevant nonhuman species should be evaluated.” (SWGDAM, July 2003).
The Yfiler® Kit provides the required degree of specificity such that it is specific to
primates. Other species do not amplify for the loci tested.

Nonhuman Studies

Nonhuman DNA may be present in forensic casework samples. The Yfiler® Kit
provides the required degree of specificity for the species tested (Figure 14).
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Figure 14 Representative electropherograms from a species specificity study including positive
and negative control
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The following experiments were conducted to investigate interpretation of Yfiler® Kit
results from nonhuman DNA sources.

The extracted DNA samples were amplified in Yfiler® Kit reactions and analyzed
using the 3100 Genetic Analyzer.

* Primates — Gorilla, chimpanzee, orangutan, and macaque (1.0 ng each).
* Non-primates — Mouse, dog, pig, cat, horse, chicken and cow (10 ng each).

* Microorganisms — Candida albicans, Neisseria gonorrhoeae, Escherichia coli 0157:H?7,
Bacillus subtilis, Staphylococcus aureus, and Lactobacillus rhamnosus (5 ng each).

The chimpanzee and gorilla DNA samples produced partial profiles within the
100-330 base pair region.

The remaining species tested did not yield reproducible detectable products.
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SWGDAM Guideline
2.3

Effect of DNA
quantity on results
and importance of
quantitation

Section 5.1 Developmental Validation
Sensitivity

“When appropriate, the range of DNA quantities able to produce reliable typing results should
be determined.” (SWGDAM, July 2003).

The amount of input DNA added to the Yfiler® Kit should be between 0.5 and 1.0 ng
(Figure 15 on page 84). The DNA sample should be quantitated prior to amplification
using a system such as the Quantifiler® Human DNA Quantitation Kit

(Part no. 4343895) or the Quantifiler® Y Human Male DNA Quantification Kit

(Part no. 4343906). The final DNA concentration should be in the range of

0.05-0.10 ng/uL so that 0.05-0.10 ng of DNA will be added to the PCR reaction in a
volume of 10 pL. If the sample contains degraded DNA, amplification of additional
DNA may be beneficial.

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in the following:

¢ Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data).
Off-scale data is a problem for two reasons:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, which results in
poor spectral separation (“pull-up”).

¢ Incomplete A nucleotide addition.
The sample can be re-amplified using less DNA.

Individual laboratories may find it useful to determine an appropriate minimum peak
height threshold based on their own results and instruments using low amounts of
input DNA.
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Stability

SWGDAM Guideline
2.4

Lack of
amplification of
some loci

Effect of inhibitors

84

Figure 15 Effect of amplifying 1 ng, 500 pg, 250 pg, 125 pg and 62 pg of male control DNA 007.
Data analyzed using the 3100 Genetic Analyzer
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Note: The y-axis scale is magnified for the lower amounts of DNA.

“The ability to obtain results from DNA recovered from biological samples deposited on various
substrates and subjected to various environmental and chemical insults has been extensively
documented. In most instances, assessment of the effects of these factors on new forensic DNA
procedures is not required. However, if substrates and/or environmental and/or chemical
insults could potentially affect the analytical process, then the process should be evaluated
using known samples to determine the effects of such factors.” (SWGDAM, July 2003).

As with any multi-locus system, the possibility exists that not every locus will amplify.
This is most often observed when the DNA sample contains PCR inhibitors or when
the DNA sample has been severely degraded. Valuable information may be obtained
from partial profiles.

Heme compounds have been identified as PCR inhibitors in DNA samples extracted
from bloodstains (DeFranchis et al.,1988; Akane et al., 1994). It is believed that the
inhibitor is co-extracted and co-purified with the DNA and subsequently interferes
with PCR by inhibiting polymerase activity.

To examine the effects of hematin on the amplification results obtained by the Yfiler®
Kit, DNA samples were amplified using the Yfiler® Kit reagents (including the
BSA-containing PCR reaction mix) in the presence of varying concentrations of
purified hematin. The concentrations of hematin used were 0 uM, 10 pM, 12 uM,

16 uM, 20 uM, and 24 uM. No preferential amplification was observed in the presence
of increasing amounts of hematin.
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Figure 16 DNA amplified with the Yfiler® Kit in the presence of varying concentrations of
hematin: 0, 10 uM, 12 uM, 16 uM, 18 uM, 20 uM, and 24 uM, analyzed on the 3100 Genetic

Analyzer
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Degraded DNA As the average size of degraded DNA approaches the size of the target sequence, the

amount of PCR product generated is reduced. This is due to the reduced number of
intact templates in the size range necessary for amplification.

Degraded DNA was prepared to examine the potential for differential amplification of
loci. High molecular weight DNA was incubated with the enzyme DNase I for varying
amounts of time. The DNA was examined by agarose gel analysis to determine the
average size of the DNA fragments at each time point.

2 ng of degraded DNA (or 1 ng undegraded DNA) was amplified using the Yfiler®
Kit. As the DNA became increasingly degraded, the loci became undetectable
according to size. Preferential amplification was not observed. The loci failed to
robustly amplify in the order of decreasing size as the extent of degradation
progressed (Figure 17).
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Figure 17 Multiplex amplification of DNA samples incubated with DNAse | (top panel = 1 ng of
DNA with no DNAse | added; remaining panels = 2 ng of DNA incubated with DNAse |)
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Mixture studies

SWGDAM Guideline
2.8

Male/female
mixture studies

86

“The ability to obtain reliable results from mixed source samples should be determined.”
(SWGDAM, July 2003).

Evidence samples may contain DNA from more than one individual. The possibility of
multiple contributors should be considered when interpreting the results. We
recommend that individual laboratories assign a minimum peak height threshold
based on validation experiments performed in each laboratory to avoid typing when
stochastic effects are likely to interfere with accurate interpretation of mixtures.

Evidence samples that contain body fluids and/or tissues originating from more than
one individual are an integral component of forensic casework. Therefore it is essential
to ensure that the DNA typing system is able to detect DNA mixtures. In the case of
Y-STRs, the female DNA component is not amplified by the Y-chromosome specific
primers. Male/female mixture studies were performed up to a ratio of 1:2000 using
three different female DNAs. The amount of female DNA was kept constant at 500 ng
and the amount of male control DNA was changed. The female DNA did not cause
any interference with the interpretation of the male Y-STR profile as shown in

Figure 18.

Low level artifacts with female DNA have been occasionally observed in the black (136
bp) and red (291 bp) dye. In general, these artifacts peaks will not affect interpretation
due to their intensity.
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Mixture studies

Figure 18 Amplification of male Control DNA 007 in the presence of female DNA 9947A. Profiles
shown in the panels from top to bottom: 500 pg of male DNA, 500 pg male DNA with 500 ng
female DNA, 250 pg male DNA with 500 ng female DNA, 500 ng female DNA.
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Male/male mixture  Forensic samples may contain body fluids or tissues originating from more than one
studies male.

Mixtures of two male DNA samples were examined at various ratios (1:1 to 1:10). The
total amount of genomic input DNA mixed at each ratio was 1 ng.

The samples were amplified in a GeneAmp® PCR System 9700 with the silver 96-well
block and were electrophoresed and detected using an Applied Biosystems® 3100
Genetic Analyzer.

Table 4 Haplotypes of samples in Figure 19

Allele Sample A Sample B
DYS19 14 15
DYS385a 11 ' 13
DYS385b 14 15
DYS3891 13 12
DYS38911 31 28
DYS390 24 ' 23
DYS391 10 10
DYS392 13 1
DYS393 13 14
DYS437 15 ' 16
DYS438 11 10
DYS439 12 13
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Allele Sample A Sample B
DYS448 19 21
DYS456 17 ' 15
DYS458 18 16
DYS635 23 22

Y GATA H4 12 12

The results of 1-ng total male/male DNA mixture studies are shown in Figure 19. The
limit of detection is when the minor component is present at approximately one-tenth
of the concentration of the major component and a threshold of 50 RFU. The limit of
detection for the minor component is influenced by the combination of genotypes in
the mixture.

Figure 19 Mixtures of two male DNA samples (A and B and A:B ratios) 1-ng input DNA. The
alleles attributable to the minor component, even when the major component shares an allele,
are highlighted.
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Population data

SWGDAM Guideline

2.7

Overview

88

“The distribution of genetic markers in populations should be determined in relevant
population groups.” (SWGDAM, July 2003)

To interpret the significance of a match between genetically typed samples, it is
necessary to know the population distribution of alleles at each locus in question. If the
genotype of the relevant evidence sample is different from the genotype of the
suspect’s reference sample, then the suspect is “excluded” as the donor of the
biological evidence tested. An exclusion is independent of the frequency of the two
genotypes in the population.
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Population data

If the suspect and evidence samples have the same genotype, then the suspect is
“included” as a possible source of the evidence sample. The probability that another,
unrelated, individual would also match the evidence sample is estimated by the
frequency of that genotype in the relevant population(s).

Population The Yfiler® Kit was used to generate the population data provided in this section.
samples used in Samples were collected from individuals throughout the United States with no
these studies geographical preference. c<?
Population Number of samples _%
African-American 333 63
U.S. Caucasian 254 g
U.S. Hispanic 175 s
‘igi.
Gene diversity Table 5 shows the Yfiler® Kit gene diversity in three populations, listed as

values percentages.

Table 5 Yfiler® Kit Gene Diversity values across three different U.S. populations

Locus African-American U.S. Caucasian U.S. Hispanic
(n=333) (n = 254) (n=175)

DYS458 0.755 0.808 0.77
DYS19 0.748 0.541 0.645

DYS385a/b 0.951 0.855 0.931
DYS393 0.619 0.412 0.507
DYS391 0.423 0.54 ' 0.52
DYS439 0.629 0.663 0.665
DYS635 0.701 0.682 0.71
DYS392 0.419 0.615 0.671

Y GATA H4 0.599 0.604 ' 0.575
DYS437 0.495 0.624 0.583
DYS438 0.528 0.622 0.712
DYS448 0.685 0.651 0.726

2
Gene diversity (D) = 86l =20} wheren = sample size, p; = allele frequency
(Johnson et al., 2003). ™~ !

Analyzing the In addition to the alleles that were observed and recorded in the Life Technologies

population data databases, other known alleles have been published or reported to us by other
laboratories. Some of these alleles occur at a low frequency and include several
microvariants (Furedi et al., 1999; Schoske et al., 2004).
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Mutation rate

Discriminatory capacity of haplotypes

Table 6 shows the discriminatory capacity (DC) and the number of unique haplotypes
(UH) for each Y-STR marker combination listed. The discriminatory capacity was
determined by dividing the number of different haplotypes by the number of samples
in that population (Schoske et al., 2004). A unique haplotype is defined as one that
occurs only once in a given population. The number of unique haplotypes is usually
less than the number of different haplotypes in any given population.

Table 6 Discriminatory capacity and number of unique haplotypes for three U. S. populations

African-American U.S. Caucasian U.S. Hispanics
Y-STR marker (N=333) (N-254) (N=175)
combination

DC (%) UH DC (%) UH DC (%) UH
“Minimal 84.6 249 74.8 162 85.1 136
haplotype”*
“US. 913 286 838 19 903 146
haplotype”t
“US. haplotype |~ 91.9 286 858 202 | 914 148
+ DYS437”
“Yfiler 99.1 327 98.8 248 98.3 169
haplotype”

1t The “minimal haplotype” includes the markers DYS19, DYS385 a/b, DYS389 I/1l, DYS390, DYS391, DYS392,
DYS393.
1 The "U.S. haplotype” includes the minimal haplotype loci plus DYS438 and DYS439.

Mutation rate

Estimation of spontaneous or induced germline mutation at genetic loci may be
achieved through comparison of the genotypes of offspring to those of their parents.
From such comparisons the number of observed mutations are counted directly.

In previous studies, haplotypes of eight loci amplified by the Yfiler® Kit were
determined for a total of 4999 parent-son (Kayser and Sajantila, 2001). Fourteen
mutations were identified and an overall average mutation rate was estimated at
2.80 x 103. In two confirmed father/son pairs mutation at two Y-STRs were observed.

Additional studies need to be performed for other loci in order to estimate their
average mutation rate.
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Mutation rate
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Overview

Section 5.2 Performance Validation After Buffer and
Enzyme Component Replacement

Overview

Experiments

92

As part of an ongoing program to exercise greater control over raw materials used in
the AmpF(STR® PCR Amplification Kits, manufacturing of the AmpliTaq Gold®
enzyme and 10X PCR Buffer II (Tris-KCl buffer) components is transitioning from
Roche Molecular Systems to Life Technologies. Manufacturing of both components by
Life Technologies will be conducted according to the same specifications used
previously by Roche. The in-house components are established raw materials in our
next generation kits (for example, the NGM™, NGM SElect and Identifiler® Plus
Kits).

We performed studies to compare the performance of the Yfiler® Kit containing the in-
house components (updated kit) with the performance of the original kit, focusing on
studies most relevant to forensic DNA testing (see SWGDAM Guidelines effective
January 1, 2011). These studies, while not exhaustive, are in our opinion appropriate
for a manufacturer. Each laboratory using the Yfiler® Kit should assess their own
requirements for evaluation of kits.

Our studies compared the performance of two Roche-manufactured enzyme and
buffer lots (Control mixes) with three new lots of buffer and two new lots of enzyme
manufactured by Life Technologies (Test mixes). Studies were performed using Test
mixes containing both the enzyme and buffer manufactured by Life Technologies.

Test_ Control Amix | Control B mix @ Test A mix Test B mix Test C mix
Material
Buffer Control Buffer | Control Buffer | Test Buffer Test Buffer Test Buffer
Lot 1 Lot 2 Lot 1 Lot 2 Lot 3
Enzyme Control Control TestEnzyme | Control TestEnzyme
Enzyme Enzyme Lot 1 Enzyme Lot 2
Lot 1 Lot 2 Lot 2

Each of the five mixes listed above were used to conduct reproducibility, sensitivity,
and inhibition studies. All amplifications were performed using a GeneAmp® PCR
System 9700 with either silver or gold-plated silver block using the recommended
amplification conditions and cycle number for the Yfiler® Kit. All data was run on an
Applied Biosystems® 3130x/ Genetic Analyzer running Data Collection Software v3.0
and analyzed using GeneMapper® ID-X Software. Subsequent data analysis was
performed using Minitab® Statistical Software. To minimize the effect of injection-to-
injection variation on result interpretation, peaks heights for all studies were
normalized using an in-house, multicolor reference standard.
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Reproducibility study

Reproducibility study

For the reproducibility study, 12 replicates of control DNA 007 at 1 ng input and three
negative control replicates were amplified. The results were evaluated for intracolor
balance, stutter percentage, and the presence, signal intensity, and location of artifacts.

Intracolor balance The Test mixes delivered lower intracolor balance results for the FAM™ dye channel
(blue) but improved intracolor balance results for the NED™ dye channel (yellow)
compared to the Control mixes. The levels of intracolor balance obtained for the Test
and Control mixes all fall within the expected range of performance for the Yfiler® Kit.
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(Figure 20).
Figure 20 Reproducibility study: intracolor balance
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Stutter Stutter percentage results for each marker were comparable across all Test and Control
percentages mixes (Figure 21).
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Reproducibility study
Figure 21 Reproducibility study: mean stutter percentage
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in all Test and Control mixes and did not exceed 50 RFU (Figure 22). No new artifacts
were observed in the Test mixes.

Figure 22 Reproducibility study: known artifacts (Y-scale 50 RFU])
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Sensitivity study

Sensitivity study

For the sensitivity study, dilution series of three genomic DNA samples were
amplified: 1 ng (three replicates each), 0.5 ng, 0.25 ng, and 0.125 ng (four replicates
each). The results were evaluated for mean referenced peak height, degree of linearity
between input DNA concentration and peak height, level of allelic dropout at 125 pg,
and genotype concordance.

Mean referenced Mean referenced peak height observations were consistent between all Test and
peak height Control mixes (Figure 23) demonstrating equivalent performance (Figure 24).

Figure 23 Sensitivity study: mean referenced peak heights three genomic DNA samples
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Figure 24 Sensitivity study: representative electropherograms for Sample 2 amplified using
125 pg input DNA (Y-scale 550 RFU)
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Sensitivity study

DNA concentration
and peak height

Allelic dropout

96

The calculated slope and R? values for each of the plotted curves were equivalent,
showing comparable relationships between peak height and DNA input amount for

the Test and Control mixes (Figure 25).

Figure 25 Sensitivity study: linear regression plot of combined mean referenced peak height for

three genomic DNA samples
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Allelic dropout was observed only for amplifications of 125 pg where dropout of a
single allele was observed for different replicates of Test A Sample 3 (Figure 26 and
Figure 27). These results can be explained by stochastic variation and sampling from
dilute DNA solutions. Allelic dropout results can therefore be considered equivalent
between Test and Control mixes.

Figure 26 Sensitivity study: electropherogram of 125 pg Sample 3 amplified with Test A mix. One
allele at the DYS635 locus in the NED™ dye (yellow) channel is below the analysis threshold of

50 RFU. (Y-scale 300 RFU)
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Sensitivity study

Figure 27 Sensitivity study: electropherogram of 125 pg Sample 3 amplified with Test A mix. One
allele at the DYS437 locus in the PET® (Red) dye channel is below the analysis threshold of

50 RFU (Y-scale 500 RFU)
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Inhibition study

Genotype Genotypes for Test and Control mixes were 100% concordant (Table 7).
concordance Table 7 Sensitivity study: genotype concordance
DNA Input Amount Reagent Mix Genotype Concordance
125 pg Test A 99%
Test B 100%
Test C 100%
Control A 100%
Control B 100%
250 pg Test A 100%
Test B 100%
Test C 100%
Control A 100%
Control B 100%
500 pg | Test A 100%
Test B 100%
Test C 100%
Control A 100%
Control B 100%
1 ng Test A 100%
Test B 100%
Test C 100%
Control A 100%
Control B 100%

Inhibition study

An inhibition series of 1 ng control DNA 007 (consisting of uninhibited control and
Humic Acid at a final concentration of 12 ng/uL in replicates of five) was amplified
using each of Test and Control mixes. The amount of each inhibitor tested was titrated
to cause an approximate 50% reduction in overall peak height of the samples. Results
were evaluated for mean referenced peak height, minimum referenced peak height,
intracolor balance, and levels of allelic dropout.

Mean referenced Uninhibited Control DNA 007 Test and Control mixes displayed no significant

play &
peak height, difference in mean referenced peak height, minimum referenced peak height, and
minimum displayed the same changes in intracolor balance as described in the reproducibility

study. For the Humic Acid-inhibited DNA, the Test Mixes containing both in-house
ref_erenced peak components showed slightly better results for mean referenced peak height, minimum
height, and referenced peak height, and intracolor balance for the FAM", PET®, and NED"" dye
intracolor balance
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channels compared to the Control Mixes or the Test Mix containing the in-house buffer
and the enzyme purchased from Roche Molecular Systems. Results for the VIC® dye
channel were more comparable across all Test and Control mixes (Figure 28, 29, and
30).

Figure 28 Inhibition study: mean referenced peak height. Inhibitors: HA = Humic Acid,
PRI = Pristine or Uninhibited DNA
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Figure 29 Inhibition study: minimum referenced peak height. Inhibitors: HA = Humic Acid,
PRI = Pristine or Uninhibited DNA
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Inhibition study

Figure 30 Inhibition study: intracolor balance. (Y-axis intracolor balance percentage versus
X-axis dye color. Inhibitors: HA = Humic Acid, PRI = Pristine or Uninhibited DNA
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Representative electropherograms from the inhibition study are shown in Figure 31
and 32.

Figure 31 Inhibition study: representative electropherograms using uninhibited Control DNA
007 (Y-scale 4000 RFU)
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Figure 32 Inhibition study: representative electropherograms using Control DNA 007 inhibited
with12 ng/pL Humic Acid (Y-scale 2500 RFU)
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Allelic dropout No allelic dropout events were seen for any Test or Control mixes tested on
uninhibited Control DNA 007 and Control DNA 007 inhibited with Humic Acid.

Conclusions

Laboratories can expect to obtain equivalent quality profiles across a wide range of
forensic samples when using the Yfiler® Kit containing the AmpliTaq Gold® enzyme
and 10X PCR Buffer II manufactured by Life Technologies as compared to the original
Yfiler® Kit containing AmpliTaq Gold® enzyme and 10X PCR Buffer Il manufactured
by Roche Molecular Systems.
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that occur

during analysis.

Table 8 Troubleshooting

Observation

Possible causes

Recommended actions

Faint or no signal from
both the AmpF(STR®
Control DNA 007 and the
DNA test samples at all
loci

Incorrect volume or absence of PCR
Master Mix or Yfiler® Primer Set

Repeat amplification.

No activation of AmpliTaq Gold® DNA
Polymerase

Repeat amplification, making sure to hold reactions
initially at 95°C for 11 minutes.

Master Mix not vortexed thoroughly
before aliquoting

Vortex the Master Mix thoroughly.

Yfiler® Primer Set exposed to too
much light

Store the Primer Set protected from light.

GeneAmp® PCR System malfunction

Refer to the thermal cycler user’'s manual and check
instrument calibration.

Use of incorrect thermal cycling
parameters

Check the protocol for correct thermal cycling
parameters.

Tubes not seated tightly in the
thermal cycler during amplification

Push reaction tubes firmly into contact with block
after first cycle. Repeat test.

Wrong PCR reaction tube

Use MicroAmp® Reaction Tubes with Caps for the
GeneAmp® PCR System 9700.

MicroAmp® Base used with tray/
retainer set and tubes in GeneAmp®
9700

Remove MicroAmp® Base from tray/retainer set and
repeat test.

Insufficient PCR product
electrokinetically injected

Prepare PCR product as described in Chapter 3,
“Perform Electrophoresis” on page 23.

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di"" Formamide.
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Observation

Possible causes

Recommended actions

Positive signal from
AmpF(STR® Control
DNA 007 but partial or
no signal from DNA test
samples

Quantity of test DNA sample is below
assay sensitivity

Quantitate DNA and add 1.0 ng of DNA. Repeat test.

Test sample contains high
concentration of PCR inhibitor (for
example, heme compounds, certain
dyes)

Quantitate DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon®-100 centrifugal
filter unit. Repeat test.

Test sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by

running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or use
the AmpF(STR® MiniFiler™ Kit.

Dilution of test sample DNA in water
or wrong buffer (for example, TE
formula with incorrect EDTA
concentration)

Redilute DNA using low-TE Buffer (with 0.1 mM
EDTA.

More than one allele
present at a locus
(except for DYS385a/b)

Presence of exogenous DNA

Use appropriate techniques to avoid introducing

foreign DNA during laboratory handling.

Amplification of stutter product

Mixed sample

See “Stutter products” on page 76.

Some but not all loci
visible on
electropherogram of
DNA test samples

Test-sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or use

the AmpF(STR® MiniFiler™ Kit.

Test sample contains high
concentrations of a PCR inhibitor (for
example, heme compounds, certain
dyes)

Quantitate DNA and add minimum necessary

volume. Repeat test.

Wash the sample in a Centricon®-100 centrifugal
filter unit. Repeat test.

Poor peak height

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler

balance parameters.
GeneAmp® PCR System 9700 with Use GeneAmp® PCR System 9700 with silver or
Aluminum 96-Well block or third- gold-plated silver blocks only, or the Veriti® 96-Well
party thermal cyclers Thermal Cycler.
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Equipment and materials not included

Table 9 and Table 10 list required and optional equipment and materials not supplied
with the Yfiler® Kit. Unless otherwise noted, many of the items are available from
major laboratory suppliers (MLS).

Table 9 Equipment

Equipment Source

3100/3100-Avant Genetic Analyzer Contact your local

Applied Biosystems® 3130/3130x( Genetic Analyzer Life Technologies_
sales representative

Applied Biosystems® 3500/3500xL Genetic Analyzer for Human Identification

Applied Biosystems® 310 Genetic Analyzer

GeneAmp® PCR System 9700 with the Silver 96-Well Block ' N8050001
GeneAmp® PCR System 9700 with the gold-plated silver 96-well block 4314878
Veriti® 96-Well Thermal Cycler 4375786
Silver 96-well sample block N8050251
Gold-plated silver 96-well sample block ' 4314443
Tabletop centrifuge with 96-well plate adapters (optional MLS

Table 10 User-supplied materials

Item? Source
AmpF(STR® Yfiler® PCR Amplification Kit 4427368
3100 Analyzer materials
96-well plate septa 4315933
Reservoir septa 4315932
3100/3130x! Genetic Analyzer capillary array, 36-cm 4315931
POP-4® polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well ' 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
OR OR
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X ' 402824
Hi-Di™ Formamide 4311320
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Itemt? Source
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-well reaction plate N8010560
250-pL glass syringe (array-fill syringe) 4304470
5.0-mL glass syringe (polymer-reserve syringe) 628-3731

For a complete list of parts and accessories for the 3100/3100-Avant instrument, refer to Appendix B of the 3700 Genetic
Analyzer and 3100-Avant Genetic Analyzer User Reference Guide (Pub no. 4335393).

3130x! Analyzer materials

96-well plate septa 4315933
Reservoir septa 4315932
3100/3130x( Genetic Analyzer capillary array, 36-cm 4315931
POP-4® polymer for 3130/3130x( Genetic Analyzers 4352755
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
OR OR
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-well reaction plate N8010560
Hi-Di™ Formamide 4311320

For a complete list of parts and accessories for the 3130/3130x( instrument, refer to Appendix A of the Applied
Biosystems® 3130/3130x( Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (Pub no. 4352716).

3500/3500xL Analyzer materials

Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4® polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4® polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 44612614
Septa Cathode Buffer Container, 3500 series 4410715
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
DS-33 Matrix Standard Kit (Dye Set G5) 4345833

For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the Applied Biosystems® 3500/3500xL
Genetic Analyzer User Guide (Pub no. 4401661)
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Appendix BOrdering Information
Equipment and materials not included

Item? Source
310 Analyzer materials
310 DNA Analyzer capillary array, 47-cm 402839
0.5 mL sample tray 5572
96-well tray adaptor (for 9700 thermal cycler trays) 4305051
GeneScan™ 500 LIZ® Size Standard 4322682
OR OR
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X 4335643
Genetic analyzer septa retainer clips for 96-tube sample tray 402866
Genetic analysis sample tubes (0.5-mL) 401957
Septa for 0.5-mL sample tubes 401956
DS-33 Matrix Standard Set (6-FAM™, VIC®, NED™, PET®, and LIZ® dyes) for 310/377 systems 4318159
MicroAmp® 8-tube strip, 0.2-mL N8010580
MicroAmp® 96-well base (holds 0.2-mL reaction tubes) N8010531
MicroAmp® 96-well full plate cover N8010550
MicroAmp® 96-well tray/retainer set 403081
POP-4® polymer for the 310 Genetic Analyzer 402838

For a complete list of parts and accessories for the 310 instrument, refer to Appendix B of the 370 Genetic Analyzer User

Guide (Pub no. 4317588).

PCR Amplification

MicroAmp® 96-well tray N8010541
MicroAmp® reaction tube with cap, 0.2-mL N8010540
MicroAmp® 8-tube strip, 0.2-mL N8010580
MicroAmp® 8-cap strip N8010535
MicroAmp® 96-well tray/retainer set 403081
MicroAmp® 96-well base N8010531
MicroAmp® clear adhesive film 4306311
MicroAmp® optical adhesive film 4311971
MicroAmp® optical 96-well reaction plate N8010560
Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
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Ordering Information
Equipment and materials not included

ltemT Source
Tris-HCL, pH 8.0 MLS
EDTA, 0.5 M MLS
Vortex MLS

t For the Safety Data Sheet (SDS) of any chemical not distributed by Life Technologies, contact the chemical manufacturer. Before handling any
chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.
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PCR Work Areas

Work area setup and labdesign............ ... i 109
PCRsetupworkarea......... ... 109
Amplified DNA workarea ... 110

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you are
using the AmpF(STR® Yfiler® PCR Amplification Kit for:

e Forensic DNA testing, refer to “Forensic Laboratories: Handbook for Facility
Planning, Design, Construction and Moving,” National Institute of Justice, 1998)

* Parentage DNA testing, refer to the “Guidance for Standards for Parentage
Relationship Testing Laboratories,” American Association of Blood Banks, 7th
edition, 2004

The sensitivity of the Yfiler® Kit (and other PCR-based tests) enables amplification of
minute quantities of DNA, necessitating precautions to avoid contamination of
samples yet to be amplified (Kwok and Higuchi, 1989).

Also take care while handling and processing samples to prevent contamination by
human DNA. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area

IMPORTANT! These items should never leave the PCR Setup Work Area.

e Calculator

* Gloves, disposable

* Marker pen, permanent
¢ Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean tube (for
Master Mix preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
¢ DPipettors
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C PCR Work Areas
Amplified DNA work area

¢ Tube decapper, autoclavable

e Vortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

You can use the following systems:
* GeneAmp® PCR System 9700 with the Silver 96-Well Block
* GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

IMPORTANT! The Yfiler® Kit is not validated for use with the GeneAmp® PCR
System 9700 with the Aluminium 96-Well Block. Use of this thermal cycling
platform may adversely affect performance of the Yfiler® Kit.

e Veriti® 96-Well Thermal Cycler
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

* Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

* Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Safety
Chemical safety

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

Minimize the inhalation of chemicals. Do not leave chemical containers
open. Use only with adequate ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.
Handle chemical wastes in a fume hood.

Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

After emptying a waste container, seal it with the cap provided.
Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.
IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

Biological hazard safety

g WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.
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Appendix DSafety
Biological hazard safety

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following:

In the U.S.:

¢ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories found at:
www.cdc.gov/biosafety

* Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030), found at: www.access.gpo.gov/nara/cfr/waisidx_01/
29¢fr1910a_01.html

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

* Additional information about biohazard guidelines is available at:
www.cdc.gov

In the EU:

Check local guidelines and legislation on biohazard and biosafety precaution
and refer to the best practices published in the World Health Organization
(WHO) Laboratory Biosafety Manual, third edition, found at: www.who.int/
csr/resources/publications/biosafety/ WHO_CDS_CSR_LYO_2004_11/en/
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Biological hazard safety
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Documentation and Support

Related documentation

Document title nF:lar:\tber

AmpFISTR® Yfiler® PCR Amplification Kit: Human Identification: Application Note 040302
3100/3100-Avant Data Collection v2.0 User Guide 4347102
3100/3100-Avant Genetic Analyzers Using Data Collection Software v2.0 User Bulletin 4350218
3100 Genetic Analyzer User Manual [Data Collection v1.1) 4315834

3100/3100-Avant Genetic Analyzers Protocols for Processing AmpFISTR® PCR Amplification Kit PCR Products 4332345
User Bulletin

Applied Biosystems® 3130/3100x( Genetic Analyzers Using Data Collection Software v3.0 User Bulletin 4363787
Applied Biosystems® 3130/3130xl Genetic Analyzers Getting Started Guide 4352715
Applied Biosystems® 3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 4352716
Applied Biosystems® 3130/3130xl Genetic Analyzers Quick Reference Card 4362825
Applied Biosystems® 3130/3130x( Genetic Analyzers AB Navigator Software Administrator Guide 4359472
Applied Biosystems® 3130/3100x! DNA Analyzers User Guide 4331468
Applied Biosystems® 3500/3500xL. Genetic Analyzer Quick Reference Card 4401662
Applied Biosystems® 3500/3500xL Genetic Analyzer User Guide, Data Collection v1.0 4401661

Applied Biosystems® 3500/3500xL. Genetic Analyzer User Bulletin: Solutions to issues related to software, data, 4445098
hardware, and consumables

Note: Additional user bulletins may be available at www.lifetechnologies.com

Applied Biosystems® 3730/3730xl Genetic Analyzer Getting Started Guide 4359476
GeneAmp® PCR System 9700 Base Module User’s Manual N805-0200
Veriti® 96-Well Thermal Cycler AmpFISTR®Kit Validation User Bulletin 4440754
Quantifiler® Kits: Quantifiler® Hurman DNA Quantification Kit and Quantifiler® Y Human Male DNA 4344790
Quantification Kit User's Manual

PrepFiler® Forensic DNA Extraction Kit User Guide 4390932
GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide 4338775
GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial 4335523
Installation Procedures and New Features for GeneMapper® ID Software v3.2 User Bulletin 4352543
GeneMapper® ID-X Software Version 1.0 Getting Started Guide 4375574
GeneMapper® ID-X Software Version 1.0 Quick Reference Guide 4375670
GeneMapper® ID-X Software Version 1.0 Reference Guide 4375671
GeneMapper® ID-X Software Version 1.1 (Mixture Analysis] Getting Started Guide 4396773
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Documentation and Support
Obtain SDSs

Document title n:ar:\tber

GeneMapper® ID-X Software Version 1.1 (Mixture Analysis) Quick Reference Guide 4402094
GeneMapper® ID-X Software Version 1.2 Reference Guide 4426481
GeneMapper® ID-X Software Version 1.2 Quick Reference Guide 4426482

Obtain SDSs

Obtain support

116

Portable document format (PDF) versions of this guide and the documents listed
above are available at www.lifetechnologies.com.

Note: To open the user documentation available from the our web site, use the
Adobe® Acrobat® Reader® software available from www.adobe.com.

Safety Data Sheets (SDSs) are available from www.lifetechnologies.com/sds.

Note: For the SDSs of chemicals not distributed by Life Technologies, contact the
chemical manufacturer.

For HID support:

¢ In North America - Send an email to HIDTechSupport@lifetech.com, or call
888-821-4443 option 1.

* Outside North America — Contact your local support office.
For the latest services and support information for all locations, go to:
www.lifetechnologies.com

At the website, you can:

* Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

* Search through frequently asked questions (FAQs)
¢ Submit a question directly to Technical Support

* Search for user documents, SDSs, vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and other product
support documents

¢ Obtain information about customer training

¢ Download software updates and patches
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Documentation and Support
Limited Product Warranty

Limited Product Warranty

Life Technologies and/or its affiliate(s) warrant their products as set forth in the Life
Technologies' General Terms and Conditions of Sale found on Life Technologies’
website at www.lifetechnologies.com/termsandconditions. If you have any
questions, please contact Life Technologies at www.lifetechnologies.com/support.
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Limited Product Warranty
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